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Introduction: About the UniEdit Manual

To accompany the recent flourish of improvements in CALIS technology, we are proud to offer
this new UniEdit documentation. In the following paragraphs, the general layout and
methodology employed will be explained.

For further introductory information, see the following section.

To look up the definition of any unfamiliar term, see the Glossary.

Section Summaries

Introduction: What is UniEdit?

The introduction explains the basic concept behind UniEdit, from its strengths to its structure.
You'll aso find important information on how to contact us at the Humanities Computing
Facility.

Getting Started with UniEdit

This section will move you right along from the introduction to UniEdit through the UniEdit
menu arrangement to working with the screen elements and producing accents and diacritics.

Specific Language Reference Manuals

This section is dedicated to the special options and keyboard shortcuts for specific languages,
especially for the “CJIK” languages—Chinese, Japanese, and Korean—and the right-to-left script
languages—Hebrew, Arabic, Persian (Farsi), Urdu, Yiddish, etc. Contact us at our address listed
on page 3 of the printed manual and in the section of On-line Help “What is UniEdit” for more
information on purchasing the CIK (Chinese-Japanese-Korean) module or the Right-to-L eft
Scripts module.

Configuring and Customizing UniEdit

This section gives pointers on how to customize your copy of UniEdit so that it best serves your
individual needs.

UniEdit Conversions

This section deals with information necessary to convert files to and from UniEdit Unicode and
other coding standards, including older versions of text CALIS and WinCaLIs 1.x files.
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Chapter 1: Getting Started with UniEdit

What is UniEdit?

UniEdit is a by-product of the development at Duke University of a Microsoft Windows version
of CALIS, caled WinCaLis. CALIS isthe “Computer-Assisted Language Instruction System.” It
combines the most innovative concepts of Computer-Assisted Learning with the soundest
pedagogical principles to equip language teachers with a stimulating educational tool. With
CALIS, teachers and courseware designers can prepare language lessons which supplement
classroom learning, i.e. create exercises to be administered, corrected, and scored individually for
each student. With the successful integration of the popular Microsoft Windows environment,
our text-based version is now available, new and improved, as WinCaLIS. Successful language
education now comes with the click of a mouse.

UniEdit is the “editor” part of WinCaLis Author, without the authoring tools.

The Strengths of UniEdit

Easy to Use

Microsoft Windows and a friendly user environment allow you to write quickly and easily.

Multilingual

UniEdit can communicate in just about any language. Presently supporting hundreds of
languages, written in more than twenty orthographic scripts (see below for sample), the open-
ended design of UniEdit’s WinCaLIs technology means the sky’ s the limit in terms of linguistic
capability. We are working in conjunction with our users to devel op the necessary fonts,
character sets, and keyboards to support even more languages.

Amharic (Ethiopic) Finnish Italian
Arabic French Japanese
Armenian Gaedlic Korean
Belarus Georgian Lappish
Bulgarian German Latin
Chinese Greek Latvian
Croatian Hausa Lithuanian
Czech Hebrew Macedonian
Danish Hungarian Maay
Dutch Icelandic Mongolian

(Cyrillic)
English Indonesian



Norwegian Russian Ukrainian
Old English Serbian Urdu
Persian (Farsi) Slovak Vietnamese
Phonetic (IPA) Spanish Yiddish
Polish Swedish Y oruba
Portuguese Tagalog
Romanian Turkish

Flexible

Specific keyboard mappings are presented as defaults but may be customized.

HELP-ful

On-line help means you are never more than a mouse-click away from the answer to your
guestion. Complete with commands and menus, the Windows help system is fast and
informative.

Structure

The UniEdit workstation package consists of three main modules. the UniEdit program itself, the
Multilingual Printer, and the TrueType Printer. All three components come under the rubric of

“WinCAaLIs Pangaea.”

The UniEdit component is that part of the UniEdit package in which you create and view your

documents. The printers allow you to print your document files.

Copyright Information
© Copyright 1998 by the Humanities Computing Facility, Duke University.

All rights reserved.

No part of this publication may be reproduced, transmitted, or transcribed, stored into aretrieval

system or trandlated into any language or computer language, in any form or by any means,
electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the prior
written consent of Duke University.

The Humanities Computing Facility reserves the right to revise this publication and to make
changes from time to time in the content of this publication without obligation of the Humanities

Computing Facility to notify any person of such revision.

Microsoft is aregistered trademark of Microsoft Corporation; Video for Windows, Windows 3.1,

Windows NT and Multimedia Movie Player are trademarks of Microsoft Corporation.

IBM is aregistered trademark of International Business Machines Corporation and PC-AT, PS/2,

and M-Motion are trademarks of International Business Machines.
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Unicode is aregistered trademark of the Unicode Consortium.

UniEdit Registration

Be sure to fill out and mail the registration form that is added to this manual so we can alert you
to all new UniEdit developments and opportunities.

Send your completed UniEdit Registration Form to:

Humanities Computing Facility
319 North Building

Box 90269

Duke University

Durham, N.C. 27708-0269 USA

Y ou must be aregistered user to access Humanities Computing Facility’s or its agents' Support Services. Please
make sure to mail or fax your registration form today.

UniEdit Support Services
Y ou may contact Duke University (Humanities Computing Facility) or its agents for Technical
Assistance regarding the functionality of the program, its subset of commands, and the way the
software works with the hardware, all as stated in the documentation.
No matter how you choose to contact us, please be prepared to provide the following information:
- Your Registration Number
- Product version number listed found by choosing About from the Help menu in UniEdit.

- The type of computer hardware you are using.

Optionally, and according to the type of question you may have, also provide us with the
following:

- Software version numbers of MS-DOS, and Microsoft Windows.
- Contents of the WINCALIS.INI file.

- Exact wording of any messages on the screen.

- What you were doing when the problem occurred.

- How you tried to solve the problem.

Electronic Mail

Ask questions and receive help from the Technical Support Department via e-mail, which is by
far the most flexible way of getting support. Just send the electronic mail to the account listed
below. This option is given the highest priority.

hcf @duke.edu



World Wide Web

http://www.lang.duke.edu, the Humanities Computing Facility Home Page, provides information
about products, events, and technical support. Demonstration WinCALIS Exercises, the UniEdit
Tryout Edition, and supplemental files may be downloaded from this site.

Fax Machine
Feel free to send us your product orders, questions or comments. Our fax number is:

919-660-3191

Telephone

If you would like to talk to us in person, or if you have questions you would like to ask us, use
these telephone numbers. Y ou can reach Technical Support Services by phone between 8:30
A.M. and 5:00 P.M., Monday through Friday. When you call, you should be at your computer
and have your documentation at hand. Be prepared to provide the information as requested on the
previous page.

919-660-3190

Address
Please fedl free to write us at the following address:

Humanities Computing Facility
319 North Building

Box 90269

Duke University

Durham, N.C. 27708-0269 USA

Y ou must be aregistered user to access Humanities Computing Facility’s or any of its agents' Support Services.
Support Services are subject to prices, terms, and conditions in place at the time the service is used.

System Requirements

Before you begin the installation process, make sure that you have all the hardware and software
you need to run UniEdit. At minimum, you will need the following:

A personal computer with an Intel 80386 or higher processor, a minimum of 4M memory,
standard VGA graphics or above.

A hard disk with 5M of free disk space and one of the following: CD-ROM drive or 3 ¥
(1.44M) disk drive.

Windows 3.1 or higher running on your machine.

Installation

The files on the UniEdit program diskettes are in compressed format. The Setup Program
decompresses the files as it copies them to your hard drive. UniEdit cannot be run from the
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diskettes included in your package. You must first install the software using the UniEdit Setup
program.

With Windows 3.1 running on your machine, select File, then Run from the Program Manager
menu bar. In Windows 95, click the Start button, then choose Run. In the dialog box that
appears, type a:\setup.exe (where a: corresponds to the 3.5 floppy disk drive of your machine).
Thiswill start the installation program.

Note: You may exit at any time during the setup procedure.

The first thing you will be asked to do is enter your name and organization or affiliation. When
you press ENTER, you will proceed to the next screen which will verify that the organization
name you just entered is correct. Next, setup will inform you of the file(s) that it will install
automatically.

Next, setup will assign a default drive and directory where the programs will be installed, unless
you specify an alternate drive and/or directory. Y ou will aso be provided with information on
space required and space available on the hard drive.

Note: If you click on Install at this point, only the UniEdit core module will be installed. To install additional
modules, click on the Optional Modules button.

Choose Individual Files

If you clicked on the Optional Modules button, a dialog box will appear listing various file
options. Y ou can choose to install only that part of UniEdit you will be working with by clicking
on the desired files with the mouse, or select the All button. When you have made your
selections, press the Continue button. If the All button is chosen, Setup will install all modules
available in UniEdit. In order to install the Chinese-Japanese-Korean option, you must have
setup disks 5, 6, 9, and 11. In order to install the Right-to-L eft Scripts option, you must have
setup disk 7.

Once the files are chosen, click on the Install button. UniEdit will verify that you have sufficient
memory on the hard drive before beginning installation.

An overview of UniEdit fundamentalsis available as a part of the installation package.

Starting UniEdit

When viewing the UniEdit group window, you will see three program-item icons, one for each of
the components of the package. We will now examine how to start UniEdit and move around in
the UniEdit environment. If you are unfamiliar with Microsoft Windows, please go through the
demonstration program provided for you on Microsoft Windows or check your Microsoft
Windows User’s Guide.

After you have Windows up and running on your machine and have installed UniEdit, select the
UniEdit program icon to start it. Y ou will be presented with a blank window for your document,
the “Document1” window. To help you understand all of your options, the on-line help system is
always available. Any changes you make and save as part of your desktop will bein effect until
you change them again, so you do not have to reset them every time you run UniEdit.
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UniEdit and Unicode

UniEdit editor is arelatively simple text processor, but a powerful multilingual editing system.
By incorporating support for Unicode™ the editor combines all of the world’ s alphabets into one
program, making UniEdit truly multilingual. The following will offer a quick overview of some
of the basic rules and methodol ogies you must know in order to understand how the UniEdit
editor works.

The UniEdit Editor is geared towards ease of multilingual editing and foreign language learning.
It does this by incorporating support from Unicode, a standard code that can map the
combination of all the world’s character sets onto your standard keyboard. Using two bytes for
each character representation, rather than one which the standard computer ASCII format uses,
65,536 unique characters can be represented, allowing UniEdit to be multilingual and
international. The aim of UniEdit was fourfold. The first wasto offer completenessin all of its
languages. Unicodeprovides this by allowing UniEdit to support up to 65,000 individual
characters. The second aim was simplicity, such that every unique character is represented with
no duplication. The third was correctness to ensure that every character isareal character as
defined by experts. Finally, we wanted to ensure fidelity so that no information would be lost
when converting text to or from existing character sets.

See aso “Unicode Character Selection Dialog Box.”

The Editor

The UniEdit Editor is a simple word-processing application that you can use to create and print
Unicode documents. To write documents, you need to know how to type, edit, and format text in
the UniEdit windows, save the file, and print document file on your printer.

All the editing windows in UniEdit share the following items:

Control Menu

The Control-menu box is in the upper-left corner of each window. The Control menu is most
useful if you use your keyboard to work with Windows. By using Control menu commands, you
can restore, move, size, maximize, minimize, and switch to other applications. (If you use a
mouse, you can perform these tasks by clicking and dragging.)

Title Bar

Thetitle bar shows the names of the editor windows that are in the Restore form along with the
task number you are currently working on.

Maximize/Minimize Buttons

Using amouse, you can click the Maximize button in the upper right-hand corner to enlarge the
active window to fill the entire screen, or you can click the Minimize button next to it to reduce
the window to an icon.



10

Restore Button

The Restore button takes the place of the Maximize button once a window has been enlarged.
The Restore button contains both an up arrow and a down arrow. If you click the Restore button,
the window will return to its previous size.

Vertical/Horizontal Scroll Bar

These can be used to move parts of a document into view when it doesn’t fit into a window.

Window Border/Window Corner

The window border is the outside of the window. By moving the mouse pointer to the window
border, you will notice the mouse pointer changes from a vertical “I-beam” to one with horizontal
double arrows. Y ou may shorten or lengthen each side of awindow by holding down the mouse
button and dragging the border when the mouse pointer shows the horizontal double arrows.

The small box at the corner of each window, called the window corner, also may be used to adjust
the size of the window. It works like the window border, but adjusts the sides of the windows at
the same time.

Insertion Point

The insertion point is the location in which the text will appear when you start typing, where
thereisablinking “caret.”

Mouse Pointer

The mouse pointer changes with the movement of the mouse. When you select Context-Sensitive
Help from the Help menu, or press Ctrl+F1, the mouse pointer changes into a Help pointer. Y ou
may click the Help pointer on any menu item or CALIS command, special response or option
keyword to get on-line help about it.

For a detailed description of the main menu bar, see the section UniEdit Menus.

See the Glossary of this manual for definitions of other Windows and UniEdit terms and
concepts.
UniEdit Editor Limits

Note: Users should be aware of the following size limitations, which affect the editing and
display of text in UniEdit windows at all times:

A maximum of 6000 lines of text is permitted in each UniEdit document window (though
limited Windows system resources may lower or slow this specification).

Tip: The TrueType Printer program provides a handy place for opening and viewing the first few pages of UniEdit
Unicode files of virtually unlimited length. And since the file is opened in read-only mode, it has some of the speed
and safety of other file viewers for DOS and Windows, like “LIST” or Xtree. You can edit avery long filein
segments of less than 6000 lines, with all but the first segment saved as type “Unicode/No Header.” Then use the
DOS command “copy /b"filel + file2 + file3 hugefile’ to concatenate the separate segments into one big file. Thisis
the procedure used for creating the large on-line UniEdit dictionaries.
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For word-wrapped text (with soft returns), thereis alimit of approximately 5000 characters
per paragraph (text between hard returns).

UniEdit will handle, but not display properly, the ends of very long lines (greater than about
260 “Medium” 21-pixels-high charactersin length. Such lines can be edited by breaking
them into two or more shorter lines, then performing needed editing, then recombining the
lines by deleting the hard returns. Alternatively, Word Wrap can be selected from the Edit
menu, and the long line will be temporarily wrapped, if it is edited (e.g., insert a space
character, then delete it) or the file is opened from disk with Word Wrap selected.

When mixing right-to-left text (Arabic or Hebrew scripts) and left-to-right text, a maximum
of 13 changes of direction is permitted per line (between hard returns).

UniEdit Document Windows

UniEdit arranges its windows and information like any other Windows application. Menus pull
down, windows are maximized (opened full-screen) and minimized (reduced to icons), sized, and
moved, all with the click of the mouse. Under the Window menu, options alow you to “tile’
your windows, i.e. have them all displayed at once liketilesin afloor, or “cascade” them, i.e.
have them overlap like folders with the most recently used ones on top. At any time you may
also “arrange” your minimized window icons with the Arrange Icons menu option.

The active window, that is, the one in which you are able to enter information at any given
moment, will be denoted by a change in intensity or hue of itstitle bar. To activate awindow,
you may click in it once or select it under the Window menu. Moving from window to window is
that simple.

UniEdit has six separate document windows, each of which is like a Unicode Notepad. To switch
from document to document, select the document window you desire from the Window menu.
UniEdit works much like a plain-text editor like the Windows Notepad or the DOS Editor, but
uses Unicode exclusively.

Accents and Diacritics

In order to produce diacritics (i.e. a modification of a character, such as an accent) and to
accommodate more characters than the standard English keyboard normally allows,
combinations of keys are sometimes used. In order to modify characters with diacritics, one must
gain afamiliarity with the keyboard layout.

The Add Accent Key = F2

The “add accent key” F2 is used to make accents and diacritics. It functions much like the Ctrl,
Shift, and Alt keys on the standard keyboard. Pressing F2, or selecting the menu item “Add
Accent,” under Edit will highlight the letter to the left of the insertion point (with blinking caret)
and the next letter pressed will overstrike the highlighted letter as a diacritical modifying accent
(grave, acute, circumflex, tilde, dieresis, etc.).

Accent Keys = Pale Blue

Each diacritic is associated with a particular character on the keyboard, appearing in pale bluein
the Keyboard Help virtual keyboard display. Anindividual diacritic may modify several
characters, such as a single accent working with several vowels. In order to display the character
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set associated with a particular diacritic, click on one of the light blue accent keys or press the
letter on the keyboard.

Note: Because accents like the circumflex (*), the tilde (~), and the double quote (), used to insert the umlaut, are
shifted keys, Shift must be pressed along with the accent key.

The accent key will turn red and the associated characters will appear in green. In some cases
there are more diacritics than displayed on the original Help keyboard. Clicking on or pressing
the Shift key will display additional accents and diacritics.

Thus to see the full set of characters modified by thetilde (~), you must first press Shift + -,
which will display the upper-case characters (shifted keys) modified by the tilde, then click on or
press Shift again to display the lower-case characters (unshifted keys) modified by the tilde.

Putting the Keys Together

After the overstrike key, accent keys, and their associated characters have been identified, the
three may be used in conjunction to create an accented character. The general procedureisto
type the character itself, the overstrike key, and the accent key in that order. Notice when the
overstrike key has been pressed, the character appears in reverse video, ready to be modified with
the diacritic. For example:

Using the English/Western Europe keyboard (which supports all Roman languages) to create an
&

1. Typethelower case “€’
2. Pressthe “overstrike key” F2
3. Press Shift+6

In order to create capital letters simply type the capital letter and then proceed as described
above.
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UniEdit Shortcut Keys

To

Get on-line help
Add Accent

Switch between two currently
used languages

Look Up Word in Dictionary

F1

F2

F3

F5






Chapter 3: UniEdit Menus 15

Chapter 3: UniEdit Menus

The File Menu

The items under the File menu alow you to create, open, or save any Unicode text file in the
currently active document window. Y ou may aso import or export filesin ANSI, IBM extended
ASCII (DOS), or other formats.

New Ctrl+N

Open...

When you are aready working in a document window and you wish to quit working on the
current document and begin working on a new Unicode text file, you must first open the File
menu and select New (Ctrl+N), in order to tell the program that it must prepare a new file to
store your commands. If you are working on another document at the time and you select New,
UniEdit will ask if you want to save the current document first before opening a new file.

Ctrl+O

The Open menu item allows you to pick a previously saved file from a specified directory so that
it may be examined or edited. When you are finished with the file, it may be Saved and reopened
at any time. 'Y ou must specify a path name for the document or scroll through directories to
make the selection.

To open an existing document:

From the File menu select Open (Alt+F,N) option.

In the File Name box, type or select the document you want to open. If the document you
want to open is not listed in the File Name box, do one or more of the following:

a. Inthe Drivesbox, select a new drive.
b. Inthe Directories box, select a new directory.

c. InthelList Files of Type box choose the type of heading which matches the format of thefile.
Y ou can open the file as a Unicode/WC 2.0 file, aBOM-headed file, a No Header file, or an
ANSI/WinCaLis 1.1 file, among others.

d. Select OK.

UniEdit can import into UniEdit format files in the following file formats:
Unicode/WC 2.0

Unicode/BOM

Unicode/No-Header

ANSI/WinCaLis 1.1

Other conversions (many formats)
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Unicode/WC 2.0

For saving filesin Unicode format with the UniEdit header (including the Unicode “Byte
Order Mark” or BOM), identifying it as a file compatible with UniEdit.

Unicode/BOM
For saving files in Unicode format preceded by the Unicode “Byte Order Mark,” (to facilitate

compatibility between machines with Intel (“little-endian”) processors and machines with
Motorola (“big-endian”) processors).

Unicode/No-Header

For saving filesin Unicode format, without the UniEdit identifying header or the BOM.

ANSI/WinCaLis 1.1

For saving ANSI-standard (I1SO 8859-1) single-byte plain-text filesto be read into a
Windows/DOS-based product (for example, Microsoft Write for Windows or any DOS Text
editor).

Other conversions
For saving filesin a variety of other single-byte, double-byte, or mixed single-and-double-

byte national coding standards, such as are used in localized versions of DOS and Microsoft
Windows.

For more information on “Other conversions,” see the section UniEdit Conversions.

Save Ctrl+S

When you open an existing document, UniEdit copies it from the disk where it is stored into
RAM memory and displaysit. Asyou work, you are actually making changes to a copy of the
document in RAM. To ensure that your latest work is stored safely on the disk, you should
frequently save your document. (Thisis easy to do—just press the shortcut key Shift+F4!) To
permanently store the contents of your document, you must saveit. This meansthat the
information becomes recorded on some permanent media, such as a floppy disk, hard drive, or
network storage system, and thus is retrievable for future use or modification. The document will
be saved to the specified directory under the current name of the file. When selecting Save for
the first time, you must provide certain information in order to tell UniEdit where to save thefile.

To save a new, unnamed document:
From the File menu, choose Save (Ctrl+S) OR

From the File menu, choose Save As (Alt+F,V) or (Ctrl+F4).

Type aname of up to eight characters in the File Name box which pops up. (UniEdit will
automatically add an extension if you do not specify one.)

Click on the OK button.
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To save the document in a different drive or directory:

From the File menu, choose Save (Ctrl+S) OR

From the File menu, choose Save As (Alt+F,V) or (Ctrl+F4).
In the Drives box, select adrive.

In the Directories box, select a directory.

Type the filename or the complete path in the File Name box.

Select OK.

Save as... Ctrl+F4

If you want to rename a previously saved document, make a backup copy, or saveit in anew
place, use the Save As... option. Y ou may then use the Windows File Manager program to delete
the old version if you so choose.

To save a UniEdit document with a different file format:

Print

From the file menu, under Text File select the menu item Save As (Alt+F,V or Ctrl+F4).
In the File Name box, type a new name for the document.
In the Save File as Type box, select the file format.
Select OK.
UniEdit can convert filesin UniEdit format to the following file formats:
Unicode/WC 2.0
Unicode/BOM
Unicode/No-Header
ANSI/WinCaLis 1.1

Other conversions (many formats)

For a detailed explanation of “Other conversions,” see the section “UniEdit Conversions.”

Ctrl+P

Selecting the File, Text File, Print menu option transfers you to one of the two UniEdit printing
utilitiesin order to print a document generated in the Scratchpad window or other window and
saved as atext file on disk. If you wish to print directly from memory (and you are using only
TrueType fonts), highlight the text to print, and choose the “Print Selection” menu option
instead.

When you select “Print,” a dialog box appears which allows you to choose which utility to use:
the TrueType Printer program (MLPTT.EXE) or the Multilingual Printer program (MLP.EXE).
Press Enter for the default selection, the TrueType Printer program.
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The UniEdit package comes with two printer programs, the TrueType Printer Program
(MLPTT.EXE), for text written in UniEdit entirely using a scalable TrueType font, and the
Multilingual Printer program (MLP.EXE), for text in any language and script. (Currently
UniEdit does not support TrueType fonts for Chinese, Japanese, Korean, afew other scripts such
as Amharic, and miscellaneous symbol and exotic Roman character fonts.)

If your text has been written using a TrueType font (most al phabetic languages), you are advised
to print with the TrueType Printer Program (MLPTT.EXE), which is faster, more powerful, and
produces superior-quality printing at any font size. If you are not sure, experiment by printing a
short test document with the TrueType Printer Program. Non-TrueType characters will merely
not display properly or not display at all on the printed page.

If you cannot print your print job successfully with the TrueType Printer, you should resort to
printing with the Multilingual Printer. This printer program is capable of printing any text which
is displayed on your UniEdit screen, in any language or script, by printing all text, whether
originaly araster font or a TrueType font, as graphics images.

You can also start either printer program by clicking on itsicon in the UniEdit Pangaea group.

For more information on printing, see also “Printing a UniEdit Document.”

Print Selection

Selected Text (marked and highlighted in reverse video) will be printed directly from memory by
the TrueType Multilingual Printer program.

Note: The Print Selection feature will not work properly for non-TrueType fonts. This includes Chinese-Japanese-
Korean, Amharic, text with IPA and other exotic Roman letters, and certain other languages supported by UniEdit for
which TrueType printing fonts are not available.

Create Keyboard...

Creates a*.WCK binary language keyboard file from its ASCII text counterpart *.MAP file
opened in the Scratchpad as an ASCII/ANSI file.

See Also “Defining Language Keyboard

Create Global File...

Creates anew WINCALIS.WGI binary global information file from its ASCII text counterpart
WINCALIS.INF, opened in the Scratchpad as an ASCII/ANSI file.

See also “The UniEdit Global Information File

Exit Alt+F4

When you are finished working with UniEdit, you should select the Exit command to return to
the program manager. If you have made any changes to the current document, UniEdit will ask
if you want to save thefile.
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The Edit Menu

Undo Alt+BkSp
Undo allows you to delete the last editing change made to the text and recall any affected text.
For example, if you delete a paragraph from your text and then change your mind, you can
employ the undo feature to bring back the paragraph. Undo may be used to undo an entire series
of editing changes.
The shortcut key for Undo is Alt+BackSpace.

Redo Alt+Shift+BkSp
Undoes the effect of Undo and restores the previous editing change, or series of editing changes.
The shortcut key for Redo is Alt+Shift+BackSpace.

Cut Ctrl+X
To cut a highlighted text block means to delete the block from the document and copy it to the
clipboard, atemporary place where text is stored for later reinsertion using the Paste command.
The shortcut keys for Cut are Ctrl+X or Shift+Delete.

Copy Citrl+C
Copying a highlighted text block islike cutting it, except the block remainsin place in the
activated window. A copy of the selected text is placed on the clipboard so that it may be
replaced in another location or window.
The shortcut keys for Copy are Ctrl+C or Ctrl+Insert.

Paste Ctrl+V
Paste takes whatever information is on the clipboard put there by the cut or copy commands and
inserts the text at the insertion point (where the blinking “ caret” islocated).
The shortcut keys for Paste are Ctrl+V or Shift+Insert.

Delete Del
Delete removes the highlighted block from the active window, but does not place it on the
clipboard. Text may immediately be restored using the Undo command.

Select All

Select All highlights all the text in the active window so it may be cut, copied or deleted. You
may also highlight text by placing the arrow at the starting point, clicking and dragging the
highlight to the end point of the text block you wish to select.
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Find...
Y ou can search for each occurrence of a combination of any characters, including uppercase and
lowercase characters, whole words, or parts of words using the Find option.

To find text:

From the Edit menu, choose Find (Alt+E,F).
In the Find box type the text, word(s), or combination of characters you want to find.
Set the options you want to control the search.

Choose the Find Next button. If an occurrence is found, the screen scrolls so you can see the
text in context.

Match Whole Word Only

Finds occurrences of the text as a whole word (no partial words). For example, the input “Tube”
would not match up with the text “Tubes’ if the “Match Whole Word only” option had been
selected.

Match Case

Finds text having a certain pattern of uppercase and lowercase |etters.

Note: A case sensitive search is much faster than a non-case sensitive search, since in the latter case, UniEdit must
consult the UniEdit Global Information File for information on upper- or lower-case equivalents for every character in
the text—even for those scripts which have no case distinction. Thus Match Case is checked by default.

Up
Searches the document above the insertion point.

Down

Searches the document below the insertion point.

Cancel

Cancels a search. Closes the Find dialog box when you are finished searching.

Note: To search for text in anon-ANSI character set, first select the appropriate keyboard from the L: [Language]
menu.

Replace...

With the Replace command, you can find and replace text. You can automatically replace all
occurrences of the found text, or selectively replace only certain instances. For example, if you
wanted to replace the word “beast” with the word “monster” you would simply type “beast” in the
Find What box, go to the Replace With box using the mouse or Tab key and enter the word
“monster.” If you wanted to replace every occurrence of the word, you would select Replace All.
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To replace text:
- Select the portion of the document you want to search. UniEdit editor searches the entire
document if you do not select a portion of the document.

From the Edit menu, choose Replace (Alt+E,R).

In the Replace box, type the text to be replaced.

Set the options you want to control the search.

To replace text, choose Replace.

To leave text unchanged and search for next occurrence, choose Find Next.

To cancel aReplace in progress or when you have finished replacing, select Cancel.

Match Whole Word Only

Finds occurrences of the text as a whole word (no partial words)

Match Case

Finds text having a certain pattern of uppercase and lowercase letters (a case-sensitive search).

Note: A case sensitive search is much faster than a non-case sensitive search, since in the latter case, UniEdit must
consult the UniEdit Global Information File for information on upper- or lower-case equivalents for every character in
the text—even for those scripts which have no case distinction. Thus Match Case is checked by default.

To replace the search text with nothing, make sure the Replace With box is empty by deleting the
contents of the box.

To undo the effects of the Replace command, choose Undo from the Edit menu as the first action
after completing the change.

Add Accent F2

Selecting the menu item Add Accent or pressing the F2 function key highlights the character to
the left of the insertion point (blinking caret) and prepares to overstrike that character with an
accent determined by the next key pressed. See the section Accents and Diacritics.

Go to Line...

Moves the cursor to the line number (Alt+E,L) you specify in the Go to Line # edit box.

Switch Languages F3

Switches between the currently selected language and the “top” language keyboard for the
workstation (by default English/W.Europe) by using the function key F3.

Note: The “top” language is determined by the default language .INI file defined in the “ Defaultini=" linein the
[WinCALIS] section of the main UniEdit initialization file “wincalis.ini,” in the UniEdit program directory. The
default language .INI fileis set by default for the United States and Western Europe to “latinl.ini.” If the default .INI
fileis changed to some other language .INI file, the “top” language will also be changed accordingly. The initial
language for use on startup in UniEdit (also by default set to English/W.Europe) is aso customizable by the UniEdit
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user. Theinitial language is determined by the setting of the InitialLanguage= line in the [Initial] section of the
“wincalis.ini” file. The out-of-the-box value for thislineis Initial Language=English/W.Europe.

Unicode Input... (Ctrl+l)

Allows you to browse through the Unicode character tables and insert a character in your text
(AIt+E,I or Ctrl+l).

Unicode Character Selection Dialog Box

The Unicode Character Selection dialog box enables you to browse through the Unicode tables
for your general information. Y ou may also insert a character in your text by going to its location
in the table, either by scrolling through Unicode character blocks or by typing all or some of its
hexadecimal Unicode character code in the edit box in the lower right corner.

Hint: Clicking above or below the slider (or “scroll box™)on the vertical scroll bar will scroll up or down afull
“page’ of 256 characters. To scroll up or down a half-page, so as to see all the characters on a page, press the up or
down scroll arrows. If you move the focus to the window by clicking anywhere in the window, you may also move
about with the cursor control keys. Pressing PageUp or PageDown will scroll up or down a full page, while the arrow
keys will move about arow or column at atime.

The shortcut key to open the dialog box in UniEdit is Ctrl+I.

i Unicode Character Selection

“%%%%fﬁﬁffff%@%mﬁ
a1 75 [ 5 2[5 [ 1 0 A 2
. 5 18 1 0 [ 5 R o o B
e[ e B 25 e e o 2 2 2
e [ 2 o, o 57 o P 2
wo. 12 2 2 [ 5 5 o
rer [ i 22 R L O i

Region displayed: CJK Unified Ideographs
Selected character: CJK Unified Ideographs I Insert | | Close g | Help gi?Fl]B

Unicode Character Blocks

Hereisalist of Unicode character “blocks,” with their starting and ending hexadecimal
Unicodes:

Start  End Block Name

0020 007E BASICLATIN
00AO OOFF LATIN-1 SUPPLEMENT
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0100
0180
0250
02B0
0300
0370
03D0
0400
0530
0590
05D0
05EB
0600
0653
0900
0980
0A00
0A80
0B0OO
0B80
0CO00
0C80
0DO00
OEO0O
OE80
10A0
10D0
1100
1EQ0O0
1F00
2000
2070
20A0
20D0
2100
2150
2190
2200
2300
2400
2440
2460
2500
2580
25A0
2600
2700
3000
3040
30A0
3100
3130
3190
3200

017F
024F
02AF
02FF
036F
03CF
O3FF
O4FF
058F
05CF
05EA
O5FF
0652
O6FF
097F
09FF
OA7F
OAFF
0B7F
OBFF
0C7F
OCFF
OD7F
OE7F
OEFF
10CF
10FF
11FF
1EFF
1FFF
206F
209F
20CF
20FF
214F
218F
21FF
22FF
23FF
243F
245F
24FF
257F
250F
25FF
26FF
27BF
303F
309F
30FF
312F
318F
319F
32FF

LATIN EXTENDED-A

LATIN EXTENDED-B

IPA EXTENSIONS

SPACING MODIFIER LETTERS
COMBINING DIACRITICAL MARKS
BASIC GREEK

GREEK SYMBOLS AND COPTIC
CYRILLIC

ARMENIAN

HEBREW EXTENDED-A

BASIC HEBREW

HEBREW EXTENDED-B

BASIC ARABIC

ARABIC EXTENDED
DEVANAGARI

BENGALI

GURMUKHI

GUJARATI

ORIYA

TAMIL

TELUGU

KANNADA

MALAYALAM

THAI

LAO

GEORGIAN EXTENDED

BASIC GEORGIAN

KOREAN HANGUL JAMO

LATIN EXTENDED ADDITIONAL
GREEK EXTENDED

GENERAL PUNCTUATION
SUPERSCRIPTS AND SUBSCRIPTS
CURRENCY SYMBOLS
COMBINING DIACRITICAL MARKS FOR SYMBOLS
LETTERLIKE SYMBOLS
NUMBER FORMS

ARROWS

MATHEMATICAL OPERATORS
MISCELLANEOUS TECHNICAL
CONTROL PICTURES

OPTICAL CHARACTER RECOGNITION
ENCLOSED ALPHANUMERICS
BOX DRAWING

BLOCK ELEMENTS

GEOMETRIC SHAPES
MISCELLANEOUS SYMBOLS
DINGBATS

CIK* SYMBOLS AND PUNCTUATION
HIRAGANA

KATAKANA

BOPOMOFO

HANGUL COMPATIBILITY JAMO
CIK* MISCELLANEOUS
ENCLOSED CJXK LETTERS AND MONTHS
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3300
3400
3D2E
44B8
4E00
=0/00)
F900
FBOO
FB50
FE20
FE30
FES0
FE70
FFOO0
FFFO

Insert

33FF  CXK* COMPATIBILITY

3D2D KOREAN HANGUL

44B7 HANGUL SUPPLEMENTARY-A

4DFF HANGUL SUPPLEMENTARY-B

9FFF  CJK* UNIFIED IDEOGRAPHS

F8FF PRIVATE USE AREA

FAFF CJK COMPATIBILITY IDEOGRAPHS
FB4F ALPHABETIC PRESENTATION FORMS
FDFF ARABIC PRESENTATION FORMS-A
FE2F COMBINING HALF MARKS

FE4F CIK* COMPATIBILITY FORMS

FE6F SMALL FORM VARIANTS

FEFE ARABIC PRESENTATION FORMS-B
FFEF HALFWIDTH AND FULLWIDTH FORMS
FFFD  SPECIALS

* “CJK” stands for Chinese-Japanese-Korean. For further Chinese-Japanese-Korean help, see the
Kangxi Radical Chart in Chapter 5.

The Insert submenu allows the user to place in text various non-displaying control characters,
such as joiners, zero-width spaces, and other special characters, to achieve certain special effects
like overriding language directionality.

Joiner Shift+F5

This character can be used to maintain certain contextual forms that would not otherwise occur.
For instance, if a character such as an Arabic letter has an initial, medial, and final form, you
may insert joinersin order to force the system to maintain an independent medial or final form.

The shortcut key to insert a Joiner is Shift+F>5.

Non-Joiner Shift+F6

The Non-Joiner works in much the same way as the joiner. Y ou may use this option to prevent
two characters from joining when they otherwise would.

The shortcut key to insert a Non-Joiner is Shift+F6.
Left to Right Override Shift+F7

Right to Left Override Shift+F8

These options allow you to manually determine the direction in which text will appear on screen.
This could be useful if, for instance, you were writing an English sentence that started with a
Hebrew word, and you wished to force the sentence to be left-justified, or conversely, a Hebrew
sentence that began with an English word, that you wished to be right-justified.

The shortcut key to insert a Left-to-Right Override is Shift+F7.

The shortcut key to insert a Right-to-Left Override is Shift+F8.
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Zero Width Space Shift+F9

This character is a no-width space character which can be used to identify word boundariesin
languages that do not have spaces between words.

The shortcut key to insert a zero-width space is Shift+Fo.

Word Wrap

Allows you to wrap text (Alt+E,W); text retrieved from disk or in any line being edited is
wrapped at the right margin of the maximum window size for the screen resolution of your
system, as reported by Windows.

The L: [Language] Menu

General Language and Keyboard Information

The language pull-down menu (Alt+L) allows you to select any of the language keyboards
available in UniEdit. Depending on the number of fonts and keyboard layouts available on your
system, the number of languages may vary from just afew to most of the languages of the world.

Western European languages such as Danish, English, French, German, Italian, Portuguese,
Spanish, and Swedish are all available with the ANSI (Latinl) Roman character set and default
“English/W.Europe” keyboard (no keyboard change required). All accents are typed with three
keystrokes (base letter + F2 + accent).

English/¥.Europe - | etlertF2 tAccent

1 2 3 4 3 E T 2 ] ] - = |

'Rt s s 7 s oo - I ]s

q w e i t 1 u i o r [ 1

[}
w
[=1}
=
=

Other languages, such as Russian or Ukrainian, with the Cyrillic character set, or Arabic or
Persian (Farsi), with the Arabic character set, require entirely different fonts and keyboards. A



symbols!, @, #, $, %, ®, &, *, or |.

When you change languages in the middle of a document, only the new text that you type will
appear in the selected language. Previously written text will not be affected.

Add Language...

Adds alanguage keyboard item to your L:[Language] menu in UniEdit from among those
available in your UniEdit program directory (i.e., for which there exist *.INI, *.MAP, and
* WCK files).

Delete Language...

Deletes alanguage keyboard item from your L:[language] menu. Only the menu listing is
deleted. The *.INI, *.MAP, and *.WCK files for each language keyboard are not deleted from
your UniEdit program directory.

Note: When you install UniEdit, it installs *.INI, *.MAP, and *.WCK files for all available languages into your
program directory by default. Add Language allows you to access any available language. If you need to economize
on disk space, after deleting a language from your menu, you may also use the File Manager to delete its *.INI,

* MAP, and *.WCK files from your hard disk, or move them to a backup storage location. *.MAP files are simply the
text versions of binary keyboard * .\WCK files, which are those used by UniEdit,. If you do not anticipate the need to
edit or add any keyboard file, you may delete all the *.MAP files from your system. See Deleting Nonessential Files
to Save on Disk Space.

The Tools Menu

Language Options

Opens additional menus for options pertaining to specific language input (e.g.. Chinese,
Japanese, Korean)

Chinese Options... Alt+F11

Opens the dialog box for setting Chinese dictionary search options. See Chinese (requires
separate CIK module).
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Chinese Status Bar

When you choose Chinese Pinyin-to Hanzi as the active language keyboard, the Chinese Status
Bar will pop up by default, displaying the current settings for Chinese input.

The Status Bar may be turned off by deselecting it here. If Chinese Pinyin-to-Hanzi is not the
currently selected language, the menu item is dimmed.

See Chinese Status Bar (requires separate CIK module).

Japanese Options...

The View Japanese Dictionary allows you to view and edit the Japanese internal Kana-Kanji
conversion dictionary. (Currently disabled.) See Japanese (requires separate CIK module).

Korean Options...

Holds the Hanja-to-Hangul (F7) and Hangul-to-Hanja (F8) conversion functions. See Korean
(requires separate CIK module).

Sort Lines...

Sorts the selected lines of text in Unicode (alphabetical) order. To browse the Unicode character
selection and order, choose Edit, then Unicode Input (or Ctrl+l), then use the scroll bar.

Generate Index

This menu option in WinCaLis Author or UniEdit runs the Unicode index builder to build an
index for adictionary filein the default "Dictionaries" subdirectory. The dictionary should be
saved as type "Unicode/No Header".

See How To Create Y our Own Dictionary

Look Up Word

If one or more on-line dictionaries have been supplied to accompany your copy of UniEdit,
selecting this menu option will initiate an on-line dictionary search. A dialog box will open,
allowing you to look up the meaning or pronunciation of a selected word or phrase. Depending
on how the dictionary was installed, it is either accessible only from specific language keyboards
(e.g, for aKorean-English dictionary, the current keyboard must be one of the Korean
keyboards), or accessible from any language keyboard which does not have a specific dictionary
linked to it (e.g, for a Korean-English dictionary, the current keyboard could be either the default
English/W. Europe keyboard or any of the Korean keyboards).

In order to select aword or phrase to look up, drag the mouse across it (or double click on it if it
isasingle word) to highlight it. Then press F5 or click on the menu item Tools, Look Up Word...
to look up the word. Repeat as often as desired.

Y ou can press the Escape key at any time during a search to cancel further searching and display
the matches found thus far.

See Also: User-Supplied On-line Dictionaries
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Set Tools

This menu option displays the Set Tools dialog box, enabling you to add, delete, or move menu
items on the Tools menu.

Check Spelling

If aspelling checker has been installed on your workstation and linked to UniEdit, selecting this
option will start the spelling checker. A copy of the spelling checker WinSpell® 3.0 isincluded
with the UniEdit workstation setup.

Print File (TrueType)

Selecting this item launches the UniEdit TrueType Multilingual Printer Program.

Print File (Bitmap)

Selecting this item launches the UniEdit Graphics Multilingual Printer Program.

Keyboard Macro

Selecting this item launches the Windows Macro Recorder, enabling you to define a keyboard
macro to type automatically and rapidly a complex or repetitive series of keystrokes.

Tools Menu Readme

Selecting this item displays information about the Tools menu and some of its functions.

The Window Menu

Tile Horizontally

Arranges open windows above and below each other in the UniEdit editor screen.

Tile Vertically

Arranges open windows side by side in the UniEdit editor screen.

Cascade

Arranges open windows partially overlapping, with their title bars visible.

Arrange lcons

Arranges the icons for minimized windows across the bottom of the screen

Desktop

UniEdit provides you with a customizable user environment. The Desktop menu options allow
you to customize your UniEdit desktop, including such aspects as which windows are open, their
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size and shape, whether or not to display the status bar at the bottom of the screen. the default
startup language keyboard, and Chinese editing and dictionary search options.

Save

Allows you to save the current desktop.

Restore Ctrl+7

Restores the Initial desktop.

Default Ctrl+8

Restores the default desktop configuration as installed by UniEdit Setup.

Status Bar

Selecting this item displays a Status Bar at the bottom of the screen.

1 Documentl (Ctrl+1)

Clicking on this menu option or pressing the shortcut key Ctrl+1 switches to the window for
Document 1.

N

Document?2 (Ctrl+2)

Clicking on this menu option or pressing the shortcut key Ctrl+2 switches to the window for
Document 2.

lw

Document3 (Ctrl+3)

Clicking on this menu option or pressing the shortcut key Ctrl+3 switches to the window for
Document 3.

I~

Document4 (Ctrl+4)

Clicking on this menu option or pressing the shortcut key Ctrl+4 switches to the window for
Document 4.

(6]

Document5 (Ctrl+5)

Clicking on this menu option or pressing the shortcut key Ctrl+5 switches to the window for
Document 5.

1o

Document6 (Ctrl+6)

Clicking on this menu option or pressing the shortcut key Ctrl+6 switches to the window for
Document 6.

The“Unsaved” Asterisk *
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When changes are made to any document, an asterisk * will be added to the title bar to indicate
that changes have not yet been saved. Once the document is saved, then the asterisk * will

disappear.

Arranging Windows and Icons

UniEdit enables you to arrange your desktop so that windows and icons are easy to see. The Tile
Horizontally option under the Window menu arranges open windows above and below each other
in the UniEdit editor window. The Tile Vertically option arranges the windows side by sidein
the UniEdit editor window. The Cascade command resizes and layers windows so that each title
bar isvisible.

To arrange windows on your desktop:
Choose Cascade or Tile from the Window menu.

Use the Arrange Icons command to evenly arrange the icons in a group window.

To arrange program-item icons:
Choose Arrange Icons from the Window menu.

To activate the editing window in UniEdit:
Using the mouse, click anywhere in one of the UniEdit windows OR

Select Window from the menu bar, and click on one of the six available editing windows
(Ctrl + 1-6)

The Help Menu

In addition to the menu options explained below, UniEdit has the following additional context-
sensitive Help features, available from the keyboard:

Keyword Search (Shift+F1)

Put your caret anywhere on a CALIS command, task option, special response, or global variable
keyword (in capital letters), or any other defined Windows Help keyword and press Shift+F1 to
call up the Help Topic(s) on that item.

Context-Sensitive Help

Highlight any menu item and press F1 (or Shift+F1 or Ctrl+F1) to go directly to the Help topic(s)
for that menu item. See al so the Context-Sensitive Help menu item below.

Contents F1

The Contents menu option provides a list of main topicsin the on-line User’s Manual available
in On-line Help, to help you understand various aspects of UniEdit. The gray Search button at the
top of the Help window is particularly useful. Y ou can search for any keywords or topics using
the Search feature and Help will find it and take you right to it. Click on “Full Table of Contents’



Chapter 3: UniEdit Menus 31

to open a separate Table of Contents window. Or press the “ Glossary” button for a glossary of
Windows and UniEdit terms, or the “Index” button for a book-style index to the on-line User’s
Manual.

Index

Opens UniEdit On-line Help and takes you directly to the Index.

Search for Help on...

Opens UniEdit On-line Help and takes you directly to the Search dialog box.

Context-Sensitive Help  Ctrl+F1

= Turns the mouse pointer into a Question-mark context-sensitive help pointer. You can
then click with the Question-mark mouse pointer on any keyword in a UniEdit command, task
option, special response, or global variable keyword or on any pull-down menu item for which
information is desired.

Keyboard Help

Keyboard Help displays on screen a picture of the current keyboard layout, with color-coded
accent overstrike keys and the letters which they affect.

About Multilingual Text Editor (UniEdit)...

About Multilingual Text Editor (UniEdit) shows the current version, date, and registration
number of your copy of UniEdit.
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Chapter 4: Printing a Document

Y ou can use UniEdit printing facilities to print any document created in UniEdit and saved as a
file on disk. The UniEdit Workstation package comes with two printer programs, the
Multilingual Printer program (MLP.EXE), for text in any language and script, and the TrueType
Printer Program (MLPTT.EXE), for text written in UniEdit entirely using a scalable TrueType
font. (Currently UniEdit does not support TrueType fonts for Chinese, Japanese, Korean, afew
other scripts such as Amharic, and miscellaneous symbol and exotic Roman character fonts.)

If your text is by default written in a TrueType font (most alphabetic languages), you are advised
to print with the TrueType Multilingual Printer Program (MLPTT.EXE), which is faster, more
powerful, and produces superior-quality printing at any font size. Y ou can start this program by
clicking on itsicon in the UniEdit Pangaea group. If you are not sure, experiment by printing a
short test document with the TrueType Printer Program. Non-TrueType characters will merely
not display properly or at al on the printed page. If this affects your print job, you should resort
to printing with the Multilingual Printer.

Multilingual Printer Program (MLP.EXE)

Selecting the File, Print menu item in UniEdit the displays the Select Printer Utility dialog box.
Selecting “Graphics Printer” launches the Multilingual Printer program (MLP.EXE). Because
the printing process takes a snapshot of every page it sends to the printer, the processis a bit
sow. However, this method allows UniEdit to work with virtually any printer, and enables you
to generate printed material in any language supported by UniEdit.

When you choose Print (Ctrl+P) from the File menu, the Select Printer Utility dialog box opens.
Choose “Graphics Printer.” Within the Multilingual Printing dialog box, you will be presented
with the following menu items:

Settings
Print

Printer Setup
Print Help

Settings

The default settings for margins, paper size, and page orientation are set so you can produce
attractive documents without having to alter the settings.

Margins

The settings you choose for margins affect all pages of a document. The default settings for
margins are fixed so you can produce attractive documents without having to change the settings.

Margin settings determine the point at which text appears on apage. If you want to emphasize
certain paragraphs, you can indent them to set them off from the margins. Y ou can change the
script’ s length and improve readability of a document by altering its margin settings.

Type the measurements for the margins you want to adjust: Top, Bottom, Left, and Right. The
measurements must be set in inches.
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Header

Prints the filename as a header at the top of each page.

Text
You can use Text formatting to align text and adjust spacing in your script. Y ou can apply Font
Size, Line Spacing, and Kerning.
Font Size
Choosing the appropriate font size for text can set the tone for a document and affect its
readability by varying the pixel sizein your script. Your selection of sizesis determined by your
printer.
Line Spacing
The default setting of 0.02 inches prints text approximately as spaced on the screen. However,
you can increase or decrease the amount of white space between lines in a document.
Kerning
Y ou can change the spacing or kerning of characters to make the script more readable.

Print Scaling
Y ou can change the size of the font in which your document is printed at a given printer
resolution, such as 150 dots per inch, from teeny-tiny (Print Scaling 1 -- i.e., 1 pixel on the
screen is printed as 1 dot on the paper), to medium (Print Scaling 2 -- i.e., 1 pixel on the screen is
doubled both horizontally and vertically as 4 dots on the paper), to magnified in size, but not
quality, through further multiplication of pixels (Print Scaling 3 and above). Default is Print
Scaling 2.

Print

Using the Print option you may print any text file.

To print a document:

From the UniEdit File menu, choose Print (Ctrl+P) to open the Select Printer Utility dialog
box. Choose “ Graphics Printer.” Or start the program by clicking on itsicon in the UniEdit
Pangaea group.

Next, in the Print menu find and select the file you wish to print.

Then press the Print button to print the document or press the Preview button to view the
document before printing.

Printer Setup

The Multilingual Printer will print on the printer installed as the Windows default printer. 1
more than one printer isinstalled, use the Windows Control Panel, Printers “applet” to set the
desired printer as the default printer. Printing options are printer-specific settings, including
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resolution, color, orientation, text quality, and others. For additional information on changing the
settings, consult your Windows manual.

TrueType Printer Program (MLPTT.EXE)

All of the UniEdit fonts can be printed using the Multilingual Printer (MLP.EXE). However,
UniEdit also supports most aphabets in TrueType fonts. Thus when printing text as TrueType,
you may want to try the TrueType Printer (MLPTT.EXE). You may use the TrueType Printer for
alphabets such as Arabic, Armenian, Cyrillic, Greek, Georgian, Hebrew, and Thai, as well as
certain other alphabetic languages. To receive updates on character sets, please contact
Humanities Computing Facility or its agents.

The TrueType Printer program also provides a handy place for quickly opening and viewing
UniEdit Unicode files. And since the file is opened in read-only mode, it has some of the speed
and safety of other file viewers for DOS and Windows, like “LIST” or XTree.

When you choose Print (Ctrl+P) from the UniEdit File menu, the Select Printer Utility dialog box
appears. Choose “ TrueType Printer.” Then in the TrueType Multilingual Printer program open
the File menu. Y ou will be presented with the following menu items:

New

Open...

Print...

Print Preview
Print Setup...
Print Settings...

You will aso see alist of the four most recently opened document files.

Print...

Using the Print menu option you may print any document file saved to disk.

To print a document:
- From the UniEdit File menu, choose Print (Ctrl+P) to open the Select Printer Utility dialog
box. Choose “ TrueType Printer.” Or start the program by clicking on itsicon in the UniEdit
Pangaea group.

Next, using the Open option in the TrueType Multilingual Printer File menu, open the file
you wish to print.

From the File menu, choose Print to print the document or Print Preview to view the
document before printing.

Print Preview

Print Preview shows an entire page at areduced size. Y ou can check page breaks, position of
text, and layout. When you choose Print Preview (Alt+F,P) from the File menu, UniEdit printing
module displays a Document dialog box with the following menu items:



36

Menu ltem:

Function:

Print

Next Page
Previous Page
Two Page

Zoom In

Zoom Out

Close

Print Setup...

Prints the document.
Displays the next page.
Displays the previous page.
Displays two pages at once.

Controls portion of the page you see in your document window. Allows you to
magnify part of a page.

Controls portion of the page you see in your document window. Allows you to
reduce part of a page.

Closes the File menu and returns you to the Multilingual Printing dialog box.

Printing options are printer-specific settings, including resolution, color, orientation, text quality,
and others. For additional information on changing the settings, consult your Windows manual.

Print Settings...

The default settings for margins, paper size, and page orientation are set so you can produce
attractive documents without having to alter the settings.
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Arabic and Hebrew (Right-to-Left) Scripts

Right-to-Left and Left-to-Right Languages Basic Information

Cursor Position

The position of the cursor at the beginning of aline is determined by the direction of the chosen
language. For example, if you choose Arabic the cursor will appear on the right side of the
window. If before typing, you switch to English the cursor will flip to the left of the window.

Cursor Movement

The direction the cursor moves is determined by the first non-neutral/directional character of the
line. If the first character encountered by the UniEdit editor is of type left to right, the cursor will
follow that direction until the line break (you press ENTER) even if the language type has
changed in the middle of the line. The same holdstrue if the first character the UniEdit editor
encounters is of the form right to left. In those instances in which a neutral character begins a
line UniEdit will not make a judgment until it encounters the first non-neutral character.

Text Order

Although the directional movement of the cursor does not change within aline, all text will
appear in its proper order. For example, if the cursor is moving from left to right and you change
to alanguage written from right to left, the text will be *pushed’ out from the cursor point. If you
switch languages again the cursor will jump over the text it ‘pushed’ out and continue the line.
Thiswill occur in the same manner if the cursor is moving right to left

Switching Directions

When mixing right-to-left text and left-to-right text, a maximum of 13 changes of direction is
permitted per line (between hard returns).
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Chinese
There are three different Chinese input methods available:
- Pinyin Phonetic Conversion
- Cangjie Input Based on Character Shape
- Character Input through Browsing Unicode

Of these, the normal method for typing and editing text is the first, pinyin phonetic method,
which has many sophisticated features to enhance efficiency. The other methods are intended to
supplement pinyin input, when you need to type arare character, or a character the pronunciation
of which you are uncertain of.

There is also a keyboard available for typing the Chinese Phonetic Alphabet (“Zhuyin Fuhao” or
“Bopomofo”) characters. Thisis not a method for entering Chinese characters.

See Also

“The Cangjie Input Method”
“Kangxi Radical Chart”

For users from Taiwan who do not know the pinyin romanization, see * Zhuyin Fuhao-Pinyin

For information on inserting characters by browsing through the Unicode tables, see “Unicode

The Pinyin Phonetic Input Method

This technique is a phonetic conversion method, based on entering Modern Standard Chinese in
phonetic transcription in the Pinyin romanization, with or without tones. WinCaLIS Author
editor takes the pinyin text and converts it into the accurate Chinese characters each time you
press the space bar or another conversion function key after typing the phonetic version of a
Chinese word or character.

Note: When mixing Chinese with any Roman-script language (such as English), a space, parenthesis, or other
punctuation mark should separate the Roman language from the pinyin in order to obtain a proper conversion.

Conversion Preference

WinCaLis Author editor takes any unconverted pinyin to the left of the cursor and converts it
when the space bar is pressed. If the string of charactersto the left of the cursor does not
congtitute a valid pinyin syllable or syllables, a message “Invalid Pinyin” will appear on the
screen.

WinCaLis Author handles the conversion process through alookup table connected to an internal
dictionary of Pinyin-Hanzi equivalents, with over 40,000 entries, including about 17,000 Chinese
characters in both simple (modern) and complex (traditional) styles, as well as polysyllabic
words. If the correct character(s) cannot be determined, because there are several homophones
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with the same pinyin, a Chinese Selection dialog box will appear and display some homophone
alternatives, arranged in order of descending frequency.

To Convert or Not to Convert?

In order to convert a collection of pinyin words previoudly typed, place the cursor at the end of
the pinyin phrase to be converted and press the space bar or other appropriate function key. If a
match can not be found within the dictionary, a message “Invalid pinyin” is displayed. Either
press the space bar or use the mouse and click on the OK button to clear the message. Y ou can
move the cursor back one syllable at atime, until part of the phrase is converted, then convert the
remaining phrase or choose individual syllables and convert them one at atime with the [F7] or
[F8] function key.

Watch Your Tones!

When typing Chinese in WinCALIS, the words must not contain any spaces or hyphens in pinyin
transcription. Enter tone marks with the number keys 1-4, then press the most suitable of several
different Convert keys. The internal dictionary will search for a correct character translation and
try to match what you have typed. A Chinese trandation is either inserted at the cursor position
of your text, or if more than one possible word is detected the Chinese Selection dialog box will
appear and you can choose the appropriate homophone. To indicate your selection click the
mouse on the word of your choice, or press the space bar to make the Selection Window active,
move up and down the list with the arrow keys until the desired word is highlighted, then press
ENTER. You can cancel the window without making a selection by pressing the ESC key.

What is Your Pinyin Status?

After each conversion, the correct toned pinyin is displayed in the Chinese Status Bar at the
bottom of the screen. The display of the pinyin text is intended to help you become familiar with
the entry that was successfully converted by WinCALIS, so that you may make an informed choice
in situations where there is some uncertainty asto the correct pinyin form, tone, and so on. This
is particularly handy when you type a pinyin form without tones and press the F8 key for an all-
tone search of the dictionary. By typing atoned form you can usually avoid the need to select
from the homophone selection window.

Y ou have a number of options for converting pinyin to characters. Most of the options are
selected with either the space bar or one of the function keys.

Functions of the Space Bar

When Chinese is the selected language in WinCaLIs or WinCALIs Author, the space bar
functions as follows:

- Chinese Space

When there is no pinyin text preceding the cursor, the space bar inserts a blank space, the length
of one Chinese character, which is equal to over two English or pinyin-size characters, at the
current cursor position.

- Convert-Word Key

When the space bar is pressed after typing aword in pinyin transcription including the proper
tones, WinCaLis will search itsinternal dictionary for a free-form word which fully matches the
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typed pinyin pronunciation, including tone: e.g., , , etc. All characters which are only bound
forms (parts of words, e.g.) are excluded, with the exception of the special case of capitalized
proper nouns. If more than one word with the same pronunciation (homophone) is found, the
choices are displayed in the Chinese Selection dialog box. If you do not see the desired word in
the Chinese Selection window, particularly in the case of single characters, cancel the window by
pressing the ESC key, then press function key F7 for afull character search. Or simply press F8
for an all-tone search (tone is ignored).

If a proper noun, such as a surname (e.g., Zhéng), the name of adynasty (e.g., Tang), or aplace
name (e.g., Beijing), istyped with an initial capital letter, it is converted directly when the space
bar is pressed, even if it is a bound form or there are other non-proper-noun homophones. If
there are two or more such matches (e.g. Zhang, Zhang), they are displayed in a selection
window.

Selecting Options from the Chinese Selection Dialog Box

When a Chinese Selection box is displayed in the screen, aword can be selected by using the
arrow keys to move from the first initial highlighted pinyin to the desired word as an aternative
to using the mouse.

The vowel (i (u-dieresis) (u with two dots over it) is typed with the ‘v’ key or CTRL + u. Therare
vowel é (e-circumflex) istyped with CTRL-e. Each of these vowels is also modifiable by the tone
marks 1-4.

When tone marks are added to a syllable, they are automatically placed over the correct vowel in
each syllable, aslong as they are typed after the first occurring vowel in each syllable. By
convention, students should be encouraged to enter the tone right after the vowel it will appear
over (like dotting an “i” or crossing a“t” immediately in printing) or at the end of each syllable
(like dotting “i”s and crossing “t”s after the end of aword in handwriting).

Certain phrase-final punctuation marks also serve as convert keys during Chinese input, thus
making it unnecessary to first press the space bar, then press the desired punctuation mark key.

(Not yet implemented.) These marks include the period (o), clause comma (,), serial comma (.),

exclamation point (!), question mark (?), and “yuandian” (-). Each of these marksistyped by
pressing the designated key on the keyboard, which is aso used for the smaller corresponding
English punctuation marks during English input. Thisis also true of the Chinese-spaced
guotation mark and Chinese space.

Other punctuation marks unique to Chinese are entered by pressing special keys. These are as

follows:

Chinese serial comma [« ) Grave accent key ()
Angle-bracket open quote { |_]| mhaft+2
Angle-bracket close quote (J b Shift+3

Double angle-bracket open quote { |7 Slaft+d
Double angle-bracket close quote (lﬂ 1 Shft+s

"Vuandian” |5 ,'f—f';se arator mark { * ) Shift+6
Chinese ditto marlk () Shift+7

All keyboard key assignments can be displayed by clicking on main menu Help then selecting
menu item Keyboard Help. A virtual keyboard picture will come up on the screen.
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Chinese Function Keys

Y ou can use the function keys on your keyboard to perform many tasks faster:

F1 Get help on the selected command, dialog box, or message

F2 Highlight the character to be accented (Accent Overstrike Key)
F3 Switch between two currently used languages

F4 Resdlect (“Oops’) key. (WinCALIS)

If aword isincorrectly converted, press F4 immediately to display the Selection Window
dialog box. Reselecting the proper word from the Selection Window will automatically
replace the incorrectly converted word.

Save current script file and continue editing (WinCALis Author)
F5 Look up highlighted word in On-line Dictionary
F6 Expand Scope of Selection (Selection Window)

Broadens the range of choice in the Chinese Selection Window when pressed during display
of a Chinese Selection window.

Allows student to give up (WinCALIS)
F7 Character Search

Initiates a dictionary search for all entriesin the dictionary which match the typed pinyin,
including tone, regardless of whether they are free words or bound morphemes.

F8 All-tone Dictionary Search

Initiates a dictionary search or all characters or words which match typed pinyin, regardless
of tone; any tone marks displayed will beignored. In All-Tone mode, initiates a search for
only those characters or words with the tone typed.

F9 Reselect (“Oops’) key. (WinCaLis Author and UniEdit)

If aword isincorrectly converted, press F9 immediately to display the Selection Window
dialog box. Reselecting the proper word from the Selection Window will automatically
replace the incorrectly converted word.

F10 Default Selection/Duplicates the last word entered.

Avoids selection from the Chinese Selection window by automatically selecting and
displaying either the most common among two or more homophone words or the one most
recently selected from a Chinese Selection window (ignores bound forms); each time a
different selection is made, that becomes the new “default” value. If pressed without any
pinyin at the cursor, F10 repeats the last selection made from a selection window (useful for
reduplication, or for quick conversions of the same word in multiple locations).

F11 Play Audio (WinCaLIS)

F12 Play Video (WinCALIS)
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Alt+F3

Alt+F4

Alt+F5

Alt+F7

Alt+F8

Alt+F9

Alt+F10

Alt+F11

Alt+F12

Set Cache/No-Cache Mode

In Cache mode, entries selected from the main dictionary on disk are added to atemporary
cache, and displayed even in No-Disk mode along with memory-dictionary entries. No-Cache
mode disables this feature.

Close the application
Set Convert/No-Convert (literal Pinyin)

In Convert mode, pinyin text at the cursor is converted into Chinese characters. In No-
Convert mode, pinyin text is left unconverted.

Alternate between Word and Character Mode.

In Word Mode, pressing the space bar searches for words (free forms) only. In Character
Mode, pressing the space bar searches for all forms, both free and bound.

Alternate between using the space bar for Tone Mode and All-Tone Mode.

In Tone Mode, pressing the space bar searches for toned forms only. In All-Tone Mode,
pressing the space bar searches for al forms, regardless of tone.

Alternate between Simple and Complex character style.

Changes the conversion of the space bar and other encode keys between complex-style
(traditional) and simple-style (modern) characters.

Alternate between Default and No-Default Search.

In Default Mode pressing the Space Bar converts the default form either the most frequently
occurring form or the most recently selected form) without any Selection Window. In No-
Default Mode pressing the space bar displays a Selection Window.

Displays the Chinese Dictionary Search Option Dialog Box.
Alternate between Disk Mode and No-Disk Mode.

In Disk Maode, pressing the space bar immediately searches both the memory and disk
dictionaries, producing alarger selection window, with more selections. In No-Disk Mode,
pressing the space bar searches the memory dictionary and the cache for matching entries.
Single entries are directly converted. If thereisa Selection Window, further entries from the
main disk dictionary are displayed by pressing the “More” button or F6.

Y our favorite settings may be saved as part of the WinCaLis “desktop” in WinCALIs Author, by
clicking on Script, Desktop, Save. The original settings are “Word, Tone, No-Default, Cache,
Convert, Simple,” which for the typical author or student user should produce the most efficient
and accurate encoding of pinyin phonetic input into Chinese characters.
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Chinese Status Bar

When Pinyin-to-Hanzi is the current language keyboard, a Status Bar at the lower left corner of
the screen displays the current settings for Chinese input.

CACHENO-CACHE
SIMFLESCOMPLEX ETYLE
PINY M Wk TH TOMES

DEFALULT/ND- DEFALLT
= [ il ke, 2 2 .
|l,J f‘ll E ||u o a" Eﬁl ﬁ" chiinwangchihan

\\\ T NEURAL NETINO-NEURAL NET

TONEALL TONE CONVERT/ND-CONVERT (FINYIN

W ORNCHARACTER

NODISKIDISH

These settings can be changed by clicking on the buttons with the mouse, by pressing the
corresponding Alt + function key combination, or by displaying the Chinese Dictionary Search
options dialog box with Alt+F11 and clicking on the desired check box. Y ou can view the
following in the Status Bar:

the WORD/CHARACTER button,

the TONE/ALL-TONE button,

the DEFAULT/NO-DEFAULT button,

the NODISK/DISK button,

the CONVERT/NO-CONVERT (PINYIN) button,

the CACHE/NO-CACHE button,

the SSIMPLE STYLE/COMPLEX STY LE button,

the NEURAL NETWORK/NO-NEURAL NETWORK button and

the PINYIN word, showing the correct toned form of the last word converted from Pinyin to Hanzi.

Special Pinyin Forms

Certain words occur so often that in addition to their regular forms, they have special alternative
toneless or non-standard pinyin forms which make them easy to enter, without the need for
selection from the Homophone Selection Window. Hereisalist of some of these ad hoc forms.
Note: Thislist includes just a sample of the neutral-tone “particles’ which are normally typed
without tone, such as“le,” “ne,” “zhe,” etc.
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b, bu (and b, bty I taa (and )

d (and de) ﬂﬂ’ﬁ] (ﬂﬂﬂ]ﬂ) tatnen (and tAmen)
di (and de, di) %Lm"ﬁ] (tﬂﬂﬂiﬂ) taamen (and tHmen)
s

p

i

HH

T () e mde ho (and )
i1 GE) e @ams ye (and 3%)
B hen (andbén)  — gi (and ¥1)
5 i (and i) 1F zai (and zi)
B (3E) i H zay (and z3i)
JL (5) ¢ mde = (&) zhe (and zhéo, Zhio, zhué, zhil)
H. shi (andsh) 4 (and )
ﬁﬂ ta (and t2)

Text in pinyin transcription aso can be entered in your document, with or without tonal diacritic
marks, by clicking on the NO-CONVERT button or pressing Alt+F5. This should facilitate the
production of printed teaching materials, glossaries, and dictionaries.

National Phonetic Alphabet (“*Zhuyin Fuhao

Under the Chinese language submenu, selection of the “Bopomofo” language enables entry of the
National Phonetic Alphabet symbolswidely used in Taiwan, and commonly known as bo-po-mo-
fo, in your text. The keyboard mapping is the standard one used in Taiwan. Note that thisis not
a bo-po-mo-fo input method, but rather a way of entering these symbolsin your text, such as
might be desired in a glossary or annotated text.

Zhuyin Fuhao-Pinyin Correspondence Table

For users familiar with the Chinese Phonetic Alphabet (“Zhuyin Fuhao” or “Bopomofo”), but not
with Pinyin romanization, the following chart of rough equivalents may be useful:

Sb07dLe LTz | @i YaHBa FanllEr | Xiu
RpLtTekgfch) T e X wud oNe‘zen | i XA\ ui
Mm 0] h T x P shi) b si) L u & ey ao Fang Xu X4 un
Cf&i Bl 1) e X ouZeng L1t X Z ong

The Cangjie Input Method

Summary of Main Principles

The Cangjie method of computer input, which is also known as the Dragon method, is afast,
reliable alphabetic typing method for Chinese characters, based on their shape, without regard to
their pronunciation. It was named by the inventor of the method, Chu Pang-fu, in Taiwan, after
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the legendary inventor of writing in Chinese antiquity, Cangjie (in Japanese, pronounced
Soketsu).

We have created for WinCaLis and WinCaLIs Author an extended, more user-friendly version of
the original Cangjie method, which makes better use of the Windows graphical interface and
mouse. Y ou can select this form of character shape-based entry under the L:[Language] menu, by
selecting the “Cangjie (by shape)” keyboard in the Chinese submenu, the “Kanji by shape’
keyboard in the Japanese submenu, or the “Hanja by shape” keyboard in the Korean submenu.

When you select one of these keyboards, a dialog box appears. Y ou can enter the letter-symbols
representing component shapes either by typing them from the keyboard in the text box or by
clicking on the piano-keyboard-style buttons, which show the letters and their corresponding
shapes.

Hereis adescription of the essentials of the original Cangjie method:

The Cangjie method allows use of the ordinary computer keyboard to encode Chinese characters,
by assigning 24 of the 26 letters of the Roman al phabet to represent the most common component
elements of Chinese characters, grouped into 24 archetypal categories, each with afull-character
label. Every Chinese character has a unique Cangjie code of from 1 to 5 letters. A space typed
after a sequence of letters signals the computer system that the code is complete and initiates a
lookup routine. (No space is required after afive-letter code.)

The letter “X” isaspecial symbol used in a small number of casesto disambiguate two characters
which would have the same Cangjie input code. The letter “Z” is used in some versions of the
Cangjie method to signal a user-defined character or phrase, or at the end of a Cangjie, asa
disambiguator, like an “X” at the beginning. (WinCALIs uses both of these systems somewhat
arbitrarily. Originaly, “X” at the beginning was used uniformly, but now “Z” at the end is used
instead for recent additions, since this fits the new user-friendly interface better.)

Mnemonic symbols
The 24 letter-symbols belong to four broad mnemonic categories:

- traditional Chinese natural philosophy (the seven heavenly luminaries and their correlatesin
the five “elements”)

(A) (sun”)  (B) (*moon”)  (C) ("metd”) (D) (*wood")
water”)  (F) (*fire")  (G) (“earth”)
- character stroke-types
(H) (“left-downward sloping stroke”) (1) (“dot”)  (J) (“cross’)

crisscross’) (L) (“vertical”) (M) (“horizontal™)

- the human body
(O) “man”)  (P) (“heart/mind”’)  (Q) (“hand”)  (R) (“mouth”)
- typical character shapes

(S) (“box open ontheside”)  (T) (“pair”)
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(U) (“box openontop’) (V) (“angle V'’ shape”)
large box™) (Y) (“dot plusline”)

As may be seen from some of the above examples, several of the letters al'so have a mnemonic
association through their own shapes:

- “V” represents V-shaped components

- components looking like half asquare S’ are represented by “S’
- U-shaped components are represented by “U”

- asmall “I” isan example of avertical stroke, represented by “L”
- a“dot” issuggested by the “dot” of the lower-case “i”

- the hook or angle of the “N” represents hook-shaped components

Order of Encoding

In entering the Cangjie code, the order of lettersis similar to, but not completely identical with,
the traditional stroke-order of Chinese characters. A character is built up left-to-right, top-to-
bottom, and from outside to inside. When a character is so complex that it has more than the
necessary number of components to uniquely identify it, the left-hand side and the first and last
components of the right-hand side are usually encoded, with the middle of the right-hand side
omitted.

In atypical character with a“radical” component on the left side, the radical is encoded with
either one letter for the entire radical, or two letters, representing its first (top) and last (bottom)
component parts. The remaining part of the character is encoded with the minimum number of
letters to distinguish it from any other characters.
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Chart Showing Cangjie Composition Principles
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Kangxi Radical Chart

Ead Kangx Statts at Ead Kangs Statts at Ead Kangs Statts at
Mo, Radical TTicode Mo, ERadical TTicode Mo, ERadical TTicode
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4 J AE3F 5] Za AES59 6] ] AES5
7 AERC [3] —— aEs0 (9] A4 4ERa
o) JL 513F 1] A 5165 121\ 516B
131 [ ] 5182 [14] 5196 [15] ¢ S1AR
s JL 51E0 17 L 51F5 1g] JJ 5200
o] 77 5208 20] 7] 59F9 21 B 5315
221 [ 5318 23] O 5338 241 5341
251 | 535 261 |4 5369 e T 5382
28] A 5386 9] X s3ce o] 53E3
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Japanese

Keyboards

Once Japanese is selected as alanguage in WinCaLis Author or Student Workstation, five
keyboard choices appear in the pull-down menu list. They are: Roman-to-Kanji, Roman-to-Kana
Only, JIS Hiragana Keyboard, JIS Katakana K eyboard and Kanji by shape. Following are
descriptions of each keyboard.

Roman-to-Kaniji

This keyboard, which provides the user with the most efficient and complete access to Japanese
characters, will transform Roman characters into kana or kanji. WinCaLis and WinCALIS
Author support the two most common systems for transliterating Japanese in Roman characters:
1) the Hepburn system, and 2) the Kunrei system. Some Japanese word-processing systems allow
many non-standard ways of entering Japanese in romanized form (e.g., “ca’ for “ka,” “jya’ for
“jalzya,” etc.). Refer to the Kana Chart to see how each character may be accessed in WinCALIS.
Keep in mind also the peculiarities of transliterating Japanese, detailed in this section.

Roman-to-Kana Only

This keyboard lets you type in kana characters without going through the buffer, so you need not
press Enter for each bunsetsu (refer to the Kana Chart to see how it accepts trandliteration). It
will automatically change Roman characters into hiragana; katakana may be accessed by pressing
Shift or CapslLock.

JIS Kana Keyboards

These keyboards transform the QWERTY keyboard into one that directly enters kana characters,
according to the Japanese Industrial Standard. For a display of the corresponding keyboard while
typing in WinCaLIs or WinCaLIs Author, click on Help, and choose Keyboard Help.

Hiragana keyboard

A BN A e R s N
el e 1R B S o A P o e s
cul |5 E{U[E]2] <] 3|09 [ #fif] cu
shift || |2 |2k 2| A|E 4| B || shift

To type a voiced kana (marked with dakuten, two dots), first type the key for its unmarked
unvoiced counterpart, then press the overstrike key, F2, then press the dakuten accent key, which
is the key marked with double quote “ (the shifted single quote * key). See the chart for an
example.

To type a kana beginning with the “p” sound (marked with handakuten circle), first type the key
for its unmarked counterpart, then press the overstrike key, F2, then press the handakuten accent
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key, which isthe “0” key (the letter “0” suggests the little circle diacritic). Seethe chart for an
example.

Kanji by shape

Kanji characters are composed of “root” shapes. Instead of retrieving a character by its
pronunciation, this keyboard allows you to locate a character by its1ooks, by elements of its root
structure. Thisis especially helpful in situations where you know what the character looks like,
but not how it is pronounced. The root structures are accessed by choosing the Kanji-by-shape
keyboard, and clicking on the piano-keyboard-style buttons. Notice that the database requires
you to preface some duplicate characters with the “X” key. To clear the Kanji by Shape Window,
simply change your Language keyboard.

For more details see the section “ The Cangjie Input Method.”

For information on inserting characters by browsing through the Unicode tables, see “Unicode

Peculiarities of Typing in Japanese
In Roman-to-Kanji keyboard,

to get: type:

%i\ w-a-t-a-3-h-1

@ W0

e g h-a

"\ h-e

Ly it-t-e

H: /‘ll,, h-o-n-n

kD kyou

ﬁ 1-0-0 OF h-y-a-k-u

ABRBC Ctrl+ Shift+a b
G T

o (bold perod) &

Particles

Particles must be entered by typing their literal romanization, that is, “w-0,” “h-a” and “h-e.”
The program won't distinguish between the character when it is part of aword, or whenitisa
particle.



WinCaLiswill include the “n” character within most words; the user may need to type an
additional “n” within other words and always at the ends of words. So, WinCaLIs will produce
the proper hiraganaif “k-o-n-b-a-n” isinput, but notice you must type “h-o-n-n" to close the end
of that word.

Long Vowels

In order to get thelong “0” sound, the user must actually typein “u,” e.g.: “k-y-o-u.” For
katakana, use the hyphen “-* for vowel extensions.

Typing in Katakana

To type in katakana, simply hold Shift or press CapsL ock in the Roman-to-Kanji or Roman to
Kana Only keyboard, or type in hiragana and then convert to katakana with the spacebar. As you
may have noticed on the kana chart, there are a few unconventional combinations of characters.
These will probably be used more for foreign words, e.g.: typein “f-o- - -m-u” (include the
hyphen for the long vowel). To convert, press the space bar, then Enter to accept the katakana
conversion to the English word “form,” which isin the program dictionary (not in the internal
dictionary). You must type in capitalsto get proper nounsin katakana.

Numbers

WinCaLiswill convert Arabic numbersto kanji. Simply type the digits while you are in the
Roman-to-Kanji keyboard, press the spacebar to convert, then highlight and enter your choice of
character(s).

The Active Buffer

There are important things to know about buffers when you are typing Japanese. If the characters
are not black, you are in an active buffer and you must do something to clear the buffer. If the
computer beeps at you, it means that you are trying to do something outside of the active buffer,
and you must clear it (by pressing Enter) before you can continue.

When in the Roman-to-Kanji keyboard, thisis the process for entering text:

When you type hiragana, the letters will appear blue (active buffer). If you want the words to
remain in hiragana, simply press Enter.

If you want to convert the words into kanji, press the space bar, while the characters are still
blue. Kanji will replace the words in blue and the sentence will appear red (active buffer). If
all conversions are correct, press Enter (Note: The maximum length of a phrase to be
converted is 32 characters. If you type the 32" character, the phrase will automatically be
converted).

If any conversions are incorrect, do the following while the characters are till red. The
reverse video block is your bunsetsu. Simply move the bunsetsu over the inappropriate
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conversion and press the Spacebar. The homophone list will appear on the screen. Move
the arrows to the desired kanji, then press Enter. The selected kanji will appear in the
phrase in reverse video. If thisis correct, press Enter again.

WinCaLis divides your sentence into bunsetsu blocks as its dictionary sees fit, but you may
change these blocks. First, convert back to hiragana by choosing it from the list (if you try to
change the bunsetsu while there is still Kanji within the active buffer, you will get a pop up
message reminding you to convert). Use the shifted left arrow to mark the first bunsetsu. At
this point, you may convert that block by pressing the spacebar, or use the arrow keysto
“jump” from block to block. To continue to change bunsetsu blocking, move to the block
that you would like to adjust, and use the shifted right and left arrow keysto shrink or
expand it.

The user may find it helpful to clear the buffer (press Enter) early and often while working in
the Roman-to-Kanji keyboard so the bunsetsu stay manageable. This will be convenient both
for maintaining kana, and in locating the desired kanji. If the homophone list does not
display the character you want, try changing the blocking of the bunsetsu. With use, you will
become more familiar with how the trandliteration process occurs within WinCALIS.

L ook at the following passage, and notice the bunsetsu blocks—the bars indicate the points where
conversions may be most efficiently placed (where the spacebar should be pressed):

(22— =LY FY] | & | FRIns |
MY, & | ZED | AL |
B | | A2 | w249 — | ¢F. |
BHo | 447 | o | HFZ3<C |
&LT%_&ﬁT%%_k#Q%TM%OI

This passage includes hiragana, katakana, kanji, and punctuation, so it is a nice exercise routine
for typing Japanese. Notice how each bunsetsu is entered:

FIE5 — 1520 P2
DwHlL. T — ML
205D — EiE o0
QML — AL
WA TIALS — ERLC
LX9 — {5 F
FHIFEH % — HitE%
FINTHO — BHO
LZdicg e HHET <
RDRLIITHBIZ LD ‘(?{f%u_k?ﬁ%%‘f‘(m%o —
RV TBIENTEBZZIEHAEHEITINB,
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The Homophone List

When you choose a kanji from the homophone list, the program will “remember” that one and
present it next time the same kana are entered. The kanji most frequently used will be given
priority over the other homophones (this does not rearrange the homophone list, which is
constant. Rather, a separate user history fileis being created and constantly updated).

Typing in Two Languages

Toggling between two languages can be done either by: clicking and dragging the mouse on the
language choice from the options list; pressing F3 to toggle to the language at the top of the
language list (usually English); or by clicking and dragging with the right-hand mouse button.

Punctuation in Japanese

Setting aside keyboard exploration time may make entering Japanese text easier. Because
Japanese uses some punctuation that is exclusive to Japanese, the characters may be hidden from
view on the standard English keyboard. Most of the punctuation parallels the basic keyboard, but
it isin a zenkaku, full-width form. The keyboard layout is displayed by clicking on Help,
Keyboard Help. Seethe chart for a sample of available marks.

Kana Kode Key

In order to obtain a kana character below, you must type in one set of Roman letter(s) listed
beneath it. The first line of rdmaji isthe Kunrei system. Where applicable, the second lineisthe
Hepburn system, and the third is nonstandard. Keep in mind the peculiarities of typing in
Japanese, detailed in this section.

H WD A B
a 1 u e o
H v v A B
Ha ol i e HO
la h I le lo
»xF L Z IR X wp B
ka Lo L le ko leya Loy Loy
Co
= T ¥ % L= Lw Lz Lax
53 1 se 50 sya sy 5yo
ce sha shu she sho

D T ¢ He Hbwbz bz
tn te to tya tyu fyo
chu tsu cha chu che cho

T v Rk o Z% L b Wk

na il i} e f1e tiya i o

ta
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LY

E”E‘gw

S EE

I E N g

Eaanat
o

Iy

3

\%

ho

b 8 CF

Vo

T8

Etau

% Ovwp [N
hiya hyu hyao
SEH S MESE
fa il te fo
Fr R Fr P Fr &
tmya tyu myo
A2 W &
¥ya Xy Yo
lya lu lyo
9 % 9w 9 x
rya ryu ryo
b Ik X
Wa o WI WE
A r
KK A HKE

LEA LEE



Chapter 5: Language Reference Manuals

57

X ¢ o

ga g gu ge go

(
B
3

£a ol ze 0
1

-2 B T ¥

da di de do

P
y BB,

r ARF
bt bu be bao
Zr AFE

=y
ba
b=

&

pa pt pu  pe  po

7o

wa uz u uxe uxo
ul ule ulo

Full-width Characters

X
2va
b
%W’a
C %
va
a .
5 x 5y
dya i
s
bya
f %

P¥a

WA VI

Xw Xk
gl gyo
Tz
g’ﬁfﬂ
Cw Uz Uk
borib} Ve ;3?0

u ie jo
5w Hz2HE
dyu dye dyo
& &
by byo
0w & x

Py Py¥e

T oy S U g

VI WVE WO

Full width Roman characters are accessed by typing Ctrl + Shift + the character. This provides
aesthetic appeal in situations where Roman characters are included within Japanese text.

Spelling Variation In Japanese

Note the potential for confusion on the student’s part (in the WinCaLIs language instruction
system) because of spelling variation allowable in written Japanese. The careful courseware
author will anticipate alternative spellings along the lines of those listed below in writing correct

and incorrect responses.



Preferred form?  Alternate acceptable form 1

H
HlL Tz
(NG
Hinz
H3
YA
17
Wisg
AP
N5
95
Wi 2,
BHL BN
AR
HMHAD

1j
HHH
HET
En3
3
SR
A
30
&2
52
2|
5%
HHEL
523
&%

Alternate form 2 (questionable)

HT N HEICH

5
=L, E. T
P <
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=w=ar

TN SO

i ﬁ«kﬂﬂf%[‘%‘@d}ﬂﬁ—zlﬁ $F

. & T
Ak

EESLY,
HI
N N

— .

(4 W e Tl
L

R

m o
o A

i
/

AN
Jv
o

-

-
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201X
X Hio
EQAL:
#HT
i3
LA
e
ey
=
il

Z
Find
HH LU DT
HEDL
HO

£5 K
DD
relyl

Z 05

5 e

A%

T

HEJ

LN

-

— A

il

LA 7z
lFA & DI

5%

RPEIR

H5<

7

S =5
% 2 i
N

HrzU.s Dizd L #

A

Note: The path to the “history” file, which stores your most recent choice among homophone alternatives, “wcjpnhst.dic,” can

be redefined by adding the following line to the [WinCALIS] section of the main initidization file “wincaisini”:

Jpnhistory=c:\wincalis\
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Korean

How to Type Hangul

Select one of the Hangul keyboards in the "Korean™ submenu of the "Language” menu. There are
four different Hangul keyboards to choose from: the Phonetic keyboard, the Standard keyboard,
the Kong keyboard, and the Morse keyboard.

The Hangul (Phonetic) Keyboard

The Phonetic keyboard is the typical student keyboard. The consonants and the vowels are

—

arranged to reflect the similar sounds of the Roman alphabet. For example, the consonant LIk

islocated on the "p" key, and the vowel ]_ islocated on the "a" key. Thus, it may be the easiest
keyboard for a native English speaker to use. However, some Korean letters do not have an

equivalent in English, and thus are placed on unused keys on the keyboard. For example, O is
located on the "g" key with no relevance to sound (but a mnemonic association with the shape of

the letter "Q"). Likewise, H looks alittlelikea"Z" onitsside, so it ison the "z" key; and

-—= , which isromanized u (a"double u") ison the "w" key. The user must become familiar
with these "exception” |etters.

Phonetic keyboard (unshifted)

+ Hangul [Phonetic] - Letter+F2+Accent

The Hangul (Standard) Keyboard

The Standard keyboard, as suggested by its name, is the standard keyboard in Korea (the Korean
typewriter keyboard). Thus, it is probably the keyboard that a native Korean would be familiar
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with. Itisdivided into two parts: The vowels are located on the right half of the keyboard, and
the consonants are located on the left half of the keyboard.

Standard keyboard (unshifted)

+ Hangul [Standard] - Letter+F2+Accent

The Hangul (Kong) Keyboard

The Kong keyboard is separated into three parts: The initial letters (consonants, such as j ,

C , €tc.) are placed on the right third of the keyboard. The medial letters (vowels such as ]_ ,

H , €tc.) are placed on the middle third of the keyboard. The final letters (consonants) are on
the left third of the keyboard. The user must be aware of these differences. For example,

although the initial and the final consonants ook the same ( ]—- , an initial on the"h" key, and

]—- , afinal onthe"s" key), they cannot be used interchangeably.

Kong keyboard (unshifted)

+ Hangul [Kong] - Letter+F2+Accent
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The Hangul (Morse) Keyboard

The Morse keyboard, among the four, requires the greatest number of keystrokes to type. There
are no compound vowels, only simple. Thus, the user must combine the simple vowels to make

+ e
compound vowels. For example, ]_ ] H . In addition, the vowels and consonants are

scattered about the keyboard in relation to frequency of use and convenience of layout of the
particular letter (similar to the arrangement of the English keyboard).

Mor se keyboard (unshifted)

+ Hangul [Morze] - Letter+FZ2+Accent

Hangul-Hanja Conversion

Hangul-to-Hanja (F8)

To convert the syllable or word to the left of the insertion point (the blinking caret) written in
Hangul into its Hanja equivalent, press the F8 function key, or click on the menu item Tools,
Language Options, Korean Options, Hangul-to-Hanja. (One of the Korean language keyboards
must be the currently selected keyboard.) The conversion engine scans to the left from the
insertion point attempting to match up to four Hangul characters. If there are homophone
equivalents, they will appear in a Selection Window. Choose the desired equivalent.

- 2] 32} %ﬁl‘
For example, to convert *—‘—‘A—] - to =y , press F8 with the insertion point to the

— ]2
right of == L
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Hanja-to-Hangul (F7)

To convert the syllable or word to the left of the insertion point (the blinking caret) written in
Hanjainto its Hangul equivalent, press the F7 function key, or click on the menu item Tools,
Language Options, Korean Options, Hanja-to-Hangul. (One of the Korean language keyboards
must be the currently selected keyboard.) The conversion engine scans to the left from the
insertion point attempting to match up to four Hanja characters. If there is more than one Hangul
equivalent (i.e., there is more than one reading for the Hanja), they will appear in a Selection

Window. Choose the desired equivalent.

3+

For example, to convert Eﬁ@
TR

Y ou can also enter Korean Hanja characters through two other methods:

Shape-based coding: The Hanja By Shape Keyboard

to - il , press F7 with the insertion point to the right of

Under the Language or L:[Language] menu, select the "Hanja by shape" keyboard in the Korean
submenu. For details on this method see “ The Cangjie Input Method”. Cangjie, the legendary
inventor of writing in ancient China, is known in Korean as Ch'anggy®él. To clear the Cangjie

Window, ssimply change your Language keyboard.

Hanja by shape keyboard

ABCDEFGHI JKLMNOPQRSTUVYWXY?Z
BRGRAKEIMEFT AT _sABigptLuEE
u:ll_l‘.f‘]'-}f]x:t'j\‘,,,x[lj,flf‘f jHuLDﬁf—-ﬂg
VL R PG VL T
£
» Fo# 111 pupk ©Z
= A=] H
18 25 45 15 PELATT AV A7 1
k

ﬁ%%ﬁmﬁw

Select

Clear |

Help |
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HOW TO TYPE KOREAN TRANSLITERATION

The Hangul (Morse) Keyboard

In order to type the special o with breve (O) and u with breve ( u ) characters necessary for the
Korean Ministry of Education or McCune-Reischauer romanization, you may choose the "Korean
Trandliteration” keyboard in the Korean submenu, as well as one of the other general
trangliteration keyboards. Y ou can type the base vowel "0" or "u," then press the overstrike key
F2, then type the mnemonic accent key for the breve "u"; or you can type them directly by

pressing "q" or "f" for " O and "x" or "v* for " W

Korean Trandliteration keyboard

i Korean Tranzliteration - Letter+FZ2+Accent
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Chapter 6: On-Line Dictionaries

User-Supplied On-line Dictionaries

Tools Menu Option "Look Up Word... F5"

Y ou can type or highlight aword or phrase on the screen and look it up in an on-line dictionary,
if one has been installed on your workstation.

If one or more on-line dictionaries have been supplied to accompany your copy of UniEdit,
selecting this menu option will open a dialog box, allowing you to look up the meaning or
pronunciation of a selected word or phrase. Depending on how the dictionary was installed, it
can be either accessible only from specific language keyboards (e.g, for a Korean-English
dictionary, the current keyboard must be one of the Korean keyboards), or accessible from any
language keyboard which does not have a specific dictionary linked to it (e.g, for a Korean-
English dictionary, the current keyboard could be either the default English/W. Europe keyboard
or any of the Korean keyboards).

Full-scale bilingual dictionaries are also available or under development for various languages.
See: Japanese-and-English On-line Dictionary and Korean-and-English On-line Dictionary.

How to Look Up a Word

In order to select aword or phrase to look up, drag the mouse across it (or double click on it if it
isasingle word) to highlight it. Then press F5 or click on the menu item Tools, Look Up Word...
to look up the word. Repeat as often as desired.

Y ou can press the Escape key at any time during a search to cancel further searching and display
the matches found thus far.
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Highlighted string for

The On-line Dictionary Dialog Box Look Up
X Eui LniEdit 11 - [Bocumend] -~ 3-27-964 HTM]
SearCh_ In: ] B8 Fie Edt L Hagu[Phenesic] Todl: Window Hels -l== |Match:
Main Entries M,g'm 2 ;-%wuq — qﬁol = 0_“:;4 " Any Part of An Entry
Everywhere n}u___] b 7} a_] A B ﬂ,mmg 25 ;1.31-,«3 o x _;;_ Start of Entry Fields
=, zFo o]l: L:I 10 PIESR-FY o - s_:._ o Whole Words
\:‘: o H ] 1 I— ”’ul I l"—'T"_ ] ; | Whole Entry Fields
Source: &SX\ . Match What:  [Any Part of An Entry Search Agal | by ; u
Highlighted Text 2I’--'T @ Main Entrics Sary Part of An Extry - = zZ| = Search Again
Gilpboad R — Py o |{SES <- <1
i ource Whole Eatry Fields :
=5 ® Highlighted Text . U © Save Settings
P> Tk L] CH_P!'“"' F Match Caae Help | I >.:|_r.'o_ — =
Mgl 7k ose
}}'D R4 _/]-a_‘ zI‘ 2 train for Pusan.
e are hands. IJH_L#‘:_:—‘E_I:\J shup Hdp
List Box Window ) 1,]]:] [-3rs toada]
(5F) to be made up of, to be made of, to consist of =
I..]- [Grona]
as; or the lilce, whether as 0-1 r ""-!ho = _L]— wn &l respects Match Case
W »] (oeaend =l
Farhelp. Press F1 MUK 00007 {0024

The On-line Dictionary Dialog Box contains various

option settings in its upper part and alist

box displaying the items found matching the word looked up in its lower part. Options are
explained below. The words in the dictionary matching the word looked up are highlighted in
reverse video. The total number of matches found is displayed in the title bar of the dialog box.

Options in the On-line Dictionary Dialog Box

Note: In order to understand the following options, note that an "entry” refers to an entire dictionary entry, which is
enclosed in an outline box within the dictionary list box. Y ou can scroll down through the displayed entries using the
mouse and the scroll bar or using the PageDown, PageUp, and arrow keys. The term "field" is used to refer to the

separate sections of awhole entry:

the main entry field, highlighted in dark green, left justified on the first line of an entry

the pronunciation or gender tag field, enclosed in square brackets, to the right on the first line

the definition field(s), beginning on the second line of

an entry

Escape Key

Y ou can press the Escape key at any time during a search to cancel further searching and display
the matches found thus far. However, since the Escape key has a special meaning in WinCALIS
(quit an exercise), Escape can not be used in WinCaLis for the first search, only from subsequent

searches when the On-line dictionary dialog is alread

Radio Button and Checkbox Options

y displayed.
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Search in:

Main Entries

Displays only the matches found in the main entry portion (field) of afull entry. The main entry
field isdisplayed in dark green at the left margin of the first line of afull entry. Main entries are
what the user of adictionary most commonly searches for. Thisis the system startup default
option.

Everywhere

Displays matches found in all fields of afull entry (displayed in dark green or in black).

Source

Highlighted Text

Uses the highlighted text as the word or phrase to look up. Thisis the system startup default
option.

Clipboard

Uses the Unicode text currently on the Windows clipboard as the word or phrase to look up. This
feature is primarily designed as away to use the WinCaALIS on-line dictionary system with other
Unicode-compliant applications. For looking up words from non-Unicode applications, use the
"Paste As..." option in the Edit Menu of the WinCaLis Composition Editor, WinCaLIs Author, or
UniEdit and select the appropriate coding standard to convert from. Then highlight the word or
phrase to look up in the normal way, using the default "Highlighted Text" as Source.

Match Case

Will match lower case or upper case by default. If unchecked, will ignore case in finding
matches. Since the WinCAaLIS system understands case relations in all the world's alphabets by
consulting a table, case-sensitive searches are considerably faster than searches which ignore
case.

Drop-down Listbox Options
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Match What:

Any Part of An Entry

The search will match any part of an entry, including phrases, words, and sequences of as few as
three letters occurring anywhere in aword. Thisis the broadest search scope. Thisis useful when
looking up words which are not likely to occur at the beginning of an entry, such as suffixes like
English "-ment" or "-tion," or when using the dictionary "in reverse," to look up words which
occur in definition fields. For example, in a Spanish-English dictionary, one would use this
option along with "Search In: Everywhere" to look up the English word "house" in order to find
its Spanish equivalent. It will find all cases where the word "house” occurs.

When looking up hanja Chinese characters in the Korean-English dictionary, this option should
be used along with either the "Search in: Main Entries* option (will match only hanja main
entries) or the "Search in: Everywhere" option (will also find any hanja occurring within the
definition fields).

Start of Entry Fields

The search will match the start of any entry field specified. For example, if "Main Entries’ only
are searched in (the default option), then "Start of Entry Fields® will match only the first letters of
the Main Entry. Thisis the next broadest search scope and is the system startup default option. If
all entry fields are searched in (the option "Everywhere"), then the " Start of Entry Fields' option
will match the first letters of any field.

Thisisthe best mode for handling language inflection, i.e., the variation of endings for verbs and
nouns--highlight only the stem portion of averb or noun to look up. Thisis also the typical
search mode we use when looking up words in print dictionaries and glossaries. In other words,
when we look up the English word "pruning,” we scan with our eyes the main entriesin a print
dictionary for "prun...," until we find the appropriate match "prune," having regularized or
"lemmatized" in our mind the "ing" form of "prune." The computer will not perform this
lemmatization automatically, so that it will not find the match "prune,” if the search string is
"pruning.” But it will find "prune” if the search string is"prun.”

Whole Words

The search will match any "whole word," which is defined as a sequence of |etters bounded by
spaces or punctuation, including the hyphen. This is the second narrowest search scope. Specific
language dictionaries may also apply specia principles. For example, in the WinCaLis Korean-
English dictionary, bound forms have been tagged with an invisible Unicode Non-Spacing Joiner,
which behaves like aregular character, so that bound forms are ignored during a "whole word"
search.

Whole Entry Fields
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The search will succeed only if the word or phrase looked up matches an entire entry field
precisely. Thisis the narrowest search scope. Matching whole entry fields has limited useful ness,
but can be helpful, for example, in matching full main entry or pronunciation fields.

Button Options

Search Again

Reinitiates a search using the current search options. It is often advisable during a lengthy search
for too broad a search string to press the Escape key and narrow the search somewhat. For
example the on-line dictionary search engine would find over 9000 matches for the search item
"giv" in the Japanese-English dictionary, since "giv" is the marker for a Japanese given name.

Save Settings

Retains the current search options for subsequent searches during the current WinCALIS session.

Close

Closes the dialog box. Y ou can also close the dialog box by pressing the Escape key.

Help

Callsup On-line Help.

Japanese-and-English Dictionary

Key to Abbreviations

an adjectival nouns or quasi-adjectives (keiyodoshi)
a-no nouns which may take the genitive case particle "no"
Vs noun or participle which takes the aux. verb suru
vt transitive verb

Vi intransitive verb

id idiomatic expression

col colloquialism

vul vulgar expression or word

pn person name (family or given)

pl place name

giv given name

fam familiar language

pol polite (teineigo) language

hum humble (kenjougo) language

hon honoarific or respectful (sonkeigo) language

pref prefix

suf suffix

uk word usually written using kana alone

uKk word usually written using kanji alone
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oK word containing out-dated kanji
io irregular okurigana usage

arch archaism

X rude or vulgar term

The WinCaLIs Japanese<-->English on-line dictionary has been adapted to the WinCaLIs on-line
dictionary system and converted to Unicode/| SO 10646 from the "Jim Breen Japanese/English
Dictionary." It is used with the permission of the copyright owner, Prof. Jim Breen of Monash
University.

We are indebted to Prof. Breen not only for his permission to adapt and distribute his
Japanese/English dictionary, but also because the simple but elegant architecture of his dictionary
provided a model for our on-line dictionary and automatic indexing system in general.

Korean-and-English Dictionary

Key to Abbreviations

(ABBR) Abbreviation

(AD) Adverb

(ADJ) Adjective
(BF)  Bound form, bound noun
Ch. Chinese

(o%)] Conjunction

Eng. English

(HS) ROK Ministry of Education "High School" hanja (hanja learned by Korean high school
students)

(IN) Interjection (including onomatopoei a)

(MS) ROK Ministry of Education "Middle School" hanja (hanja learned by Korean middle
school students)

(N) Noun
(NC)  Numeral classifier (numerical counter, measure)
(Obs.) Obsolete or archaic form

(PA)  Particle, auxiliary word
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(PF)  Prefix

(PN)  Proper noun (personal name, place name)
(PR)  Pronoun

(SF)  Suffix

(VE) Veb

(VC) Verb causative

(VG) Verbgerund

(V1) Verbintransitive

(VN)  Verba noun

(VT) Verbtransitive

Key to Symbols

E> An arrow indicates a cross-reference, synonym, or other relevant usage.

[ ] Solid lenticular brackets enclose hanja Chinese character information in an "Okp'yon”
character-dictionary-style field. See the item “Hanja Okp'yon Field” below for more
information.

K EI Hollow lenticular brackets enclose the variant inflected stem forms of common verbs.

[ ] Tortoise shell brackets enclose hanja Chinese character equivalents for Sino-Korean

noun and bound morpheme (BF) entries.

< A less-than sign means " (etymologically) derived from." Etymologies have been
included for many recent loan words of European origin.

O Parentheses enclose usage tags, meaning clarifications, and specialized terminol ogy.
E.g., "(Music)" indicates a term used especially in musical terminology; "(Medicine)"
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indicates aterm used especially in medical terminology; and "(Obs.)" indicates an
obsolete or archaic form.

General Features

Layout

A sample dictionary entry is pictured below, with labels for each field. See below for further
details on each field and on other dictionary options.

Main Entry field Pronunciation field

A (7)) el

(I city, town, (BF) marlket, fair; trade; execution ground [2—] E]—T‘ﬁ MS]

Definition field hanja "Okp'yon" field

Main entry field

Main entries are highlighted in dark green. For verbs the main entry includes the dictionary
citation form, as well as variant inflected forms for the most common and short verbs, enclosed
in hollow lenticular brackets. The purpose of this is both for reference and to make it easier to
locate a verb by highlighting and looking up its stem element. For Sino-Korean nouns, the hanja
Chinese character equivalent is given, enclosed in tortoise shell brackets.

Pronunciation field

The second field of each entry, after the main entry on the same lineg, is the pronunciation field,
enclosed in square brackets. Pronunciation is given according to the McCune-Reischauer
pronunciation.

Alternate pronunciations are provided within the definition field, preceded by "Also":
Note example entry:

j (3R] ]

(BF) music. Also "-H]" E_I]‘pleasure, Q. delight in, like. [%Nﬂ. MS

Definition field

Definitions in English, derived forms (e.g., adjectives or verbs formed from nouns), examples
with English trandlations, and usage information are all presented in the definition field,
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beginning on the line following the main entry field. Distinct definitions are grouped under
separate Arabic numerals, in accord with common Korean lexicographic practice. For most
verbal nouns ending with hada, the noun is given as the main entry, and the hada form is given
within the definition field.

Hanja "Okp'yon” field

The entries for the most common morphemes of Chinese origin end with a hanja "Okp'yon"
Chinese character dictionary-style field, enclosed in solid lenticular brackets. This usually
contains first a Korean "tag meaning" for the morpheme (hanja character). Second is the hanja
character itself. Third is an approximate indication of frequency of usage, if it is one of the 1800
characters designated as the most important for educational purposes by the Ministry of
Education of the Republic of Korea. "MS" indicates that it is one of the most common 900
characters which are taught in middle school in the Republic of Korea. HS indicates the next
most common 900 characters, which are taught in high school in the Republic of Korea.

Serial Arrangement

Entries are arranged in ascending hangul alphabetical order, in the order of the Unicode/l SO
10646 encoding standard. This order isin turn based on the Korean Standard KS C 5601-1989.

For more information on Unicode, consult The Unicode Consortium, The Unicode Sandard:
Worldwide Character Encoding. Version 1.0, Vol. 2 (Reading , Mass: Addison-Wesley, 1992);
for more information on SO 10646, consult the document 1SO/IEC 10646-1:1993 Part 1:
Architecture and Basic Multilingual Plane (available from ANSI, 11 West 42nd St., New Y ork,
NY 10036).

Note: In 1996 the Unicode/I SO 10646 code points for all Korean hangul shifted from their location in the code range
3400-4D00 under the existing Unicode 1.1 standard to their new location in the code range AC00-D7A3 in the
proposed revised standard Unicode 2.0/1S010646-?:1997. In order to both accommodate the existing standard and
anticipate the future standard within the WinCaLis Korean-English dictionary, the dictionary lookup engine has been
designed to handle either range of code points. The dictionary is distributed in two different versions, one for Unicode
1.1 and one for Unicode 2.0. Either can be installed on the user's system, or both can be installed simultaneoudly, if
they are linked to one or more separate language keyboards under the Language menu--for example the existing
"Hangul (Phonetic)" keyboard can be linked to the dictionary using the Unicode 1.1 standard, while a new "Hangul
(Phonetic) Alt." keyboard can be linked to the dictionary using the Unicode 2.0 standard. In order to access a specific
dictionary, then, the user would need to switch keyboards to the desired one before looking up aword. In theory,
these two dictionaries could be combined and reindexed together, so as to alow looking up Korean hangul encoded
in either Unicode 1.1 or Unicode 2.0, but this not only would produce a dictionary double the current size, but also
would have the undesirable effect of displaying duplicate entries for all hanja and English words looked up. It would
also be more difficult to maintain and extend.

Grammar
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The system of grammar employed is generally that of Fred Lukoff, as found in his textbook, An
Introductory Course in Korean (2nd edition, Seoul:Y onsei University Press, 1993). The
monumental dictionary A Korean-English Dictionary by Samuel E. Martin et al. (New Haven:
Yale University Press, 1967) was a so extensively consulted, as well as most of the common
Korean-English dictionaries published in Korea for learners of English.

Scope

The dictionary contains about 22,000 main lexical entries, with several thousand more derived
forms given in the body of the entries. Pains have been taken to ensure that virtually all the
vocabulary items presented in the Korean textbooks commonly used in the United States have
been incorporated here. Other special areas of coverage which have been incorporated include:

- over four hundred lexical items which are unique to North Korean usage, with equivalent South
Korean usage added as a cross-reference; indicated with the usage tag "(N. Korea)"

- common geographic names, both Korean and foreign

- common Korean surnames (marked "surname”)

- common Chinese surnames (marked "Ch. surname")

Entries have been provided for all of the 4888 hanja Chinese characters from the Korean
Standard KS C 5601-1989, plus others not included in the KS standard which are used to write
common vocabulary. Each entry gives the hangul reading and McCune-Reischauer transcription.
Many of these hanja have obscure meanings or no meaning at all when used independently, so in
order to avoid distorting their function, they have been simply marked in the definition field with
the phrase "[rare combining form]." However, it is hoped that the pronunciation provided will be
of value in identifying and reading them when they occur in the names of places and persons.

Acknowledgments:

We are very grateful to the following teachers and scholars for their advice in the design and
compilation of this Korean-English dictionary: Mrs. Yang S. Camus, Prof. Kay Kang, Mrs.
Young Ah Lee (Chief Editor), Mr. Bo Park, Dr. Bruce Phinney, Prof. Han Sohn, Prof. Janna
Son-Y arborough, and Mr. Sukmaoon Y oon.

How to Create Your Own On-line Dictionary
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The item "Look Up Word..." in the Tools menu is a powerful new feature in WinCALIS.
Depending on what isinstalled on a particular workstation, WinCaLis, WinCALIs Author, or
UniEdit (the WinCaLis Multilingual Text Editor) can access an unlimited number of Unicode-
text on-line dictionaries. These dictionaries can be either multilingual (e.g., Russian-Arahic,
Arabic-Russian), or monolingual (e.g., adictionary of specialized vocabulary for advanced
students of English). Any author can generate a dictionary by creating a (Unicode) text filein
WinCaLis Author or UniEdit in afixed format, like:

EntryField/Pron.or Gender Field/UsageField/DefinitionField1l....

There should be one entry per line, separated by hard returns, and with fields separated by
dlashes (/). Note that because the slash has a special meaning, it is areserved character and
should not be used within fields. The EntryField will start a new entry and will be highlighted in
dark green color. The second field ("Pron.orGenderField") will be placed on the same line
surrounded by square brackets. If the second field is empty—that is, there are two successive
dlashes (//), the brackets will be replaced by a colon (:). Succeeding fields will be placed on new
lines. The maximum length for an entire entry is practically speaking about 512 characters, since
that is about how much can be viewed in the on-line dictionary list box at one time.

When you have created a small pilot dictionary file in atext window, save the fileto disk in the
\WINCALIS\DICTS subdirectory (or whatever path you have specified in the "Dictionaries="
line of WINCALIS.INI), with the file extender ".DIC", specifying the file type "Unicode/No
Header" in the "Save File as Type:" box.

Then you need to generate the index to your dictionary. In WinCaLis Author or UniEdit, in the
Tools menu, click on "Generate Index" and specify the name of the dictionary to generate the
index for. Usually you should specify the same 1-8 letter filename for both the dictionary and the
index to be generated. E.g., if your dictionary file is named "wcrusfrn.dic,” then the index should
be named "wcrusfrn.idx.”

At this time you can also select alanguage keyboard to associate the new dictionary with, if you
wish to use more than one language dictionary. When that keyboard is the active keyboard in
WinCaLis, WinCaLIs Author, or UniEdit, this dictionary will be the one which is used.
WinCaLis Author or UniEdit will create or update a [Dictionary] section in the corresponding
language-keyboard .INI file on your workstation. Anytime after you restart WinCALIS and
WinCaLis Author, or UniEdit, if that language-keyboard is the current keyboard, the programs
will ook for your dictionary and index file in the .\WINCALIS\DICTS directory or other
directory specified in the "Dictionaries=" line of WINCALIS.INI.

Note: In order to associate your dictionary with more than one keyboard, you may use the Windows Notepad to open
the .INI file of the keyboard you first selected (check the time/date stamp on the file in the File Manager to determine
which oneit is, if you can't spot it), then copy the entire [Dictionary] section to the Clipboard and paste it into as
many other .INI files as you wish. (See LATINLINI for a sample.) See also Language Keyboard .INI Files.

When you press the "OK" button in the Generate Index dialog box, Author or UniEdit will begin
to create the index file. For a small pilot dictionary of just afew items, this process takes only a
few seconds or minutes. But for areal glossary or dictionary of thousands of entries, and with
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many items to index, expect the index generation process to take 1-3 hours, even on afast
machine. It generally works well to start the index generator at the end of a day and let it run
during the night. Also, be sure that there is plenty of free space on the hard drive for the several
hundred temporary files which are created during the indexing process--at least 2-3 times the
total size of the dictionary file itself.

Every alphabetic sequence of 3 letters will be fully indexed, as will every single Han character for
Chinese-Japanese-K orean-Vietnamese. Note that at the moment there is no way to index 2-letter
words such as English "to" or "by." Thereis also not yet a"stop-word" function, which will
exclude certain 3-letter combinations, like "and," from being indexed.

When index generation is completed, the dictionary and index files are finished and ready to use.
If you wish students to have access to your dictionary, you will need to arrange to install the
dictionary files on the student workstation(s) and link them to keyboards as needed. If you would
like to contribute your dictionary as a general enhancement to the WinCALIS system, we can pre-
install your dictionary in student workstations.

Note that the default dictionary and index names are WINCALIS.DIC and WINCALIS.IDX. A
dictionary with that name will be found regardless of the current keyboard, unless another
dictionary is specified for the current keyboard.

Users who are developing large dictionaries should review editing limits imposed by the
Author/UniEdit editor. In particular, note that there is alimit of 6000 lines of text in each
window in WinCALIS Author and UniEdit. There can be up to six concurrent 6000-line texts,
one in each window. Y ou will need to develop your dictionary in component parts of ca. 5000
lines each. Then you can use the DOS COPY command or a DOS batch file to concatenate each
of the component files into one big file (hence the "Unicode/No-Header" file type). Thereisa
sample batch file, UPDATE.BAT, included in the .\WINCALIS\DICTS directory during setup.

The dictionary file does not need to be in any particular order, and sorting it (with the " Sort
Lines' item under the "Tools" menu) is useful mostly to avoid duplicate entries and so that
display of itemsin the dictionary is in ascending order, when the word looked up is hot amain
entry. Y ou can sort multiple component files in the same way you might sort a stack of cardsto
be alphabetized by first dividing it into piles by initial letter, then proceeding to al phabetize each
of the piles, then recombining all the pilesin order. Y ou would proceed by sorting each of your
files, then chopping each of them into eighth-length files (or quarters or halves or 1/20ths,
depending on the total length of your dictionary--you will need as many divisions as you have
component files) at logical divisions (e.g, in the Latin alphabet, a-c, d-f, g-i, j-I, m-0, p-r, s-u, v-
z, then combining all the first-eighth files and resorting them; then all the second-eighth files
and resorting; and so on. When all the sub-files are reassembled and sorted, they can be
reassembled. The entire dictionary should now be in sorted Unicode order. A sample DOS batch
file to do the concatenating operation mechanically isincluded in the .\WINCALIS\DICTS
subdirectory. Be sure that you keep master copies of all component sub-files--remember that full
dictionary files exceeding 6000 lines are not directly editable or even viewable in the WinCALIS
editor. If you accidentally combine all your component files and fail to keep the components, you
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Tools

can, in apinch, use afile utility such as“SPLIT49.EXE” to split the big file again at even byte
boundaries into any number of components. SPLIT49.EXE and its documentation,
SPLIT49.DOC can be downloaded from the Humanities Computing Facility website,
http://www.lang.duke.edu.

We are in the process of developing large bilingual dictionaries for Korean-and-English and
Japanese-and-English. We hope that with the collaboration of interested WinCALIS authors and
users, we will be able to distribute useful dictionaries to accompany WinCALIS for awide range
of languages.

Menu Option "Generate Index"

This menu option in WinCaLIs Author or UniEdit runs the automatic Unicode index builder to
build an index for adictionary filein the default "Dictionaries’ subdirectory. The dictionary
should be saved as type "Unicode/No Header".
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Chapter 7: Configuring and Customizing UniEdit

These are various topics related to the general subject of customizing your UniEdit Workstation
S0 it serves you the best, maximizing your productivity.

To learn how to set the font size for use in your UniEdit, set default directories, change the
virtual keyboard picture, change the Language Menu, and much more, see “The Main UniEdit
Initialization File WINCALIS.INI.”

To learn how to change or fine-tune the default font(s) for use in your UniEdit, see “The Default

To learn about how to make your own language keyboard or modify an existing one, see
“Defining Language Keyboard Files.”

To learn about how the Unicode-smart UniEdit system globally defines punctuation,
capitalization, and accented characters, see “The UniEdit Global Information File

To learn how to add an on-line dictionary, see “User-Supplied Dictionaries.”
To learn more about UniEdit fonts and typefaces, see “Fonts.”
To find out about setting up a Spelling Checker, see “Linking to a Spelling Checker.”

To find out which UniEdit files are essential and which you can get rid of without worry, see
“Deleting Nonessential Filesto Save on Disk Space.”

For tips on network installation and operation of UniEdit, see “Installing UniEdit on a Network.”

To find out how to remove the UniEdit Workstation from your system, see “How to Uninstall

The Main UniEdit Initialization File WINCALIS.INI

General Tips

The main UniEdit initialization file WINCALIS.INI, which contains al kinds of customizable
settings, is to be found in the main UniEdit program directory (usually the parent directory of the
default scripts directory).—e.g., C\WINCALIS. It is created dynamically at the time of
installation. It isatypical ASCII Windows *.INI file. It can be edited with a plain-text editor like
the Windows Notepad. Be sure to use the Windows File Manager or other tool to make a backup
copy of WINCALIS.INI, before you make any changesin it.

If you are currently running UniEdit, you will have to exit and restart it for any new settings to
take effect.

If you wish to make only atemporary change to one or another setting in your WINCALIS.INI
file, you can leave the Notepad running in the background, with the WINCALIS.INI file still
openinit. Then after you have finished using UniEdit, you can return to the Notepad and change
the setting back again.
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To change the default font for use in UniEdit, you will need to edit another UniEdit system file,
The Default Character-to-Font Mapping File WCFNT.INF.

Changing the Default Font Size for Use in UniEdit

(For how to change the font or typeface itself, see The Default Character-to-Font Mapping File
WCFNT.INF.)

UniEdit always displays text in “Medium” font size. But you can define Medium as any pixel
height you choose, provided the font is available. Here’ s how to do it. UniEdit will still use
“Medium” for any font it needs. But you can redefine the value of “Medium” to any pixel height.

The actua point size of the “Medium” used by UniEdit is determined by the pixel height settings
in the default language .INI file defined in the “ Defaultini=" line in the [WinCALIS] section of
WINCALIS.INI. The default language .INI fileis set for the United States and Western Europe to
“LATINLINI.” Changing theline “Medium=21" in the [FontSize] section of “LATINL.INI” to
some greater or smaller pixel height than 21 pixels will adjust the size of the default font
accordingly in UniEdit. All pixel heights are set by default for standard VGA resolution
(640x480 pixels) as follows:

Tiny=12
Fine=16
Small=19
Medium=21
Large=32
Xlarge=48
Huge=66.

So to change the font size for ANSI (all West European languages), edit the LATINZL.INI file.
(The procedureisidentical for other character sets—Cyrillic, Greek, Hebrew, Thai, etc.)
Redefine the following line to any desired pixel height.

Medium=19
Then exit UniEdit and restart UniEdit.

You can leave the LATINLINI file running in Notepad in the background. Then when you no
longer need asmaller or larger font size, restore the original settings and save the file again.

Special versions of “latinl.ini” for use with EGA monitors and with VGA monitors at higher
than standard VGA resolution are distributed as part of the UniEdit and Student Workstation
packages.

The pixel heights for the fonts in many other character sets can be adjusted in the same way, by
specifying the pixel heights in the language keyboard *.INI file you will first use to type that
character set, generating that font on your screen.

Setting the Virtual Keyboard Type
The virtual keyboard picture displayed when Keyboard Help is selected is defined in the

WINCALIS.INI file in the main UniEdit subdirectory. It can be redefined by carefully editing the
linein the [WinCALIS] section
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KeyboardType=0

Keyboard arrangements are perhaps best described by the position of the backslash (reverse
solidus) key (at least for U.S. keyboards). Substitute a number corresponding to one of the
following available pictures:

- Type 0: Backdash key (\) on top row, next to Backspace key (default)
. Type 1: Backslash key (\) on 2™ row from top, below Backspace key
- Type 2: Backslash key (\) on bottom row at extreme right, below Enter key

- Type 3: Backdash key (\) on bottom row at extreme left

Changing the UniEdit Desktop

In the Desktop submenu under the Window menu you can “Save” the current desktop
arrangement, “Restore” the previous arrangement, or go back to the “ Default” arrangement, as it
was set in WINCALIS.INI during installation of the UniEdit Workstation. Here's how each of
these sections looked in your WINCALIS.INI out of the box:

[Initial]

Word=Yes
Tone=Yes

Def=No
NoDisk=Yes
Simple=Yes
NoConvt=No
NoCache=No
Net=Yes

Initial Language=English/W.Europe
Document1=MAX
Document2=ICON
Document3=ICON
Document4=ICON
Document5=ICON
Document6=ICON
Active=Document1
Wordwrap=Y es
Statusbar=Y es

[Default]
Word=Yes
Tone=Yes
Def=No
NoDisk=Yes
Simple=Yes
NoConvt=No
NoCache=No
Net=Yes

Initial Language=English/W.Europe
Document1=MAX
Document2=ICON
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Document3=ICON

Document4=ICON

Document5=ICON

Document6=ICON

Active=Document1

Wordwrap=Y es

Statusbar=Y es

The first eight lines in each section refer to Chinese internal dictionary search options, which are
also a part of the desktop configuration.

Setting the Top and Initial Languages in your Language Menus

The “top” language in your UniEdit L: menu is determined by the default language .INI file
defined in the “Defaultini=" line in the [WinCALIS] section of WINCALIS.INI. The default
language .INI fileis set by default for the United States and Western Europeto “LATINL.INI" If
the default .INI file is changed to some other language .INI file, the “top” language will aso be
changed accordingly.

Theinitial language for use on startup in UniEdit (also by default set to “ English/W.Europe”) is
also customizable by the user. Theinitial language is determined by the setting of the
InitialLanguage= line in the [Initial] section of the WINCALIS.INI file. The out-of-the-box value
for this line is Initial Language=English/W.Europe.

Rearranging the Language Menus

Thelist of languages and keyboards in the L:[Language] menu in UniEdit is constructed
dynamically out of the language keyboard *.INI and *.WCK files present in the UniEdit program
directory each time you run either of these programs.

Thelist is arranged into language or script grouping submenus, each one containing various
language keyboards, based on the list of Submenus and *.INI filesin the [WinCALIS] section of
WINCALIS.INI reproduced below.

A typical Language Menu-related section of WINCALISINI

[WinCALIS]

SubMenul=Arabic script
SubMenu2=African
SubMenu3=Asian (other)
SubMenu4=Chinese
SubM enu5=Europe (other)
SubM enu6=Japanese
SubMenu7=Specia Fonts
SubMenu8=Cyrillic script
SubMenu9=Hebrew script
SubMenul0=Korean
SubMenull=Indic scripts
Language20=AMHARIC
Language60=ARMENIAN
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Language30=ARABICC
Language50=ARABICX
Languaged0=ARABUSG
Language90=BELARUS

L anguage140=BOPOMOFO
Languagel00=-BULGARIA
Languagel50=CANGJE
Languagel20=CENTASIA
Languagel30=CHINESE
Languagel80=CROATIAN
Languagel90=CZECH
Language220=DUTCH
Language230=EEUR
Language240=ENGLISH
Language250=FORMSY MB
Language260=FRENCH
Language280=GEORGIAN
Language300=GERMAN
Language320=GREEK CAL
Language330=GREEKPC
Language360=HAUSA
Language400=HEBREWI
Language420=HEBREWK
Language430=HEBREWT
Language410=HEBREWU
Language510=HIRAGANA
Language460=I1BM-PC
Language470=IPA
Language480=ITALIAN
Language540=KANJICJ
Language530=KATAKANA
Language560=K OREANK
Language570=K OREANM
Language580=K OREANS
Language590=K OREANU
Language600=K ORHANJA
Language640=LATIN
Language650=LATVIAN
Language660=LI THUAN
Language680=MACEDON
Languaged50=MAGY AR
Language700=M ONGOL
Language710=PASHTO
Language720=PERSIANC
Language730=PERSIANP
Language740=PERSIANX
Language750=POLISH
Language760=PORTUG
Language490=ROMAJ
Language500=ROMAJINC
Language810=ROMANIAN
Language780=RUSSIANC
Language790=RUSSIANS
Language800=RUSSTECH
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Language820=SCANDIN
Language830=SERBIAN
Languages40=SINDHI
Languages850=SLOVAK
Language870=SPANISH
Language890=TAGALOG
Language920=THAI
Language930=TRANSLIT
Language940=TURKISH
Language950=UK RAINE
Language960=URDU
Language9d70=VIETNAME
Language980=Y IDDISH
Language990=Y ORUBA

For example, the line “Languagel00=BUL GARIA” tells UniEdit to look for a file named
BULGARIAL.INI. Its sequencein the list of ascending numbers “Language#’ more or less
determines the alphabetical sequence in the language menu or submenu of the language keyboard
identified within BULGARIA.INI, which happens to be Bulgarian.

UniEdit then looks in the file BULGARIA.INI. It looks like this:

A typical language keyboard *.INI file

[Language]
Name=Bulgarian
Face=Times
SubMenulD=8
RightL eft=0
CharSet=0
Keyboard=Bulgaria
Languagel D=100
Pitch=2
DeadKey=
Font1=Kiev
Font2=M oscow
Font3=Sofia

[FontSize]
Tiny=12
Fine=16
Small=19
Medium=21
Large=32
ExtraL arge=48
Huge=66

The “Name=Bulgarian” line determines the menu listing, which will be just that, “Bulgarian,”
and the SubMenul D=8 line places the listing for Bulgarian in the “ Cyrillic script” subdirectory.

UniEdit then gets the name of the *.WCK keyboard file from the “ Keyboard=Bulgaria’ line and
looks for the file BULGARIA.WCK. If it finds such afile, it will fully enable the menu listing. If
it failsto find thefile, it will display the menu listing for Bulgarian dimmed.
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For the ANSI character set (Unicode page 0) you can freely add as many fonts here as are
available (and which you believe will also be available to students working your lessons). For
other character sets, fonts must be consistent with the UniEdit Unicode-character-to-font
mapping tables UNI2FNT1.WCF....UNI2FNT6.WCF. Fonts designed for use in non-Unicode
compliant systems, such as Windows 3.1 word processing programs, will not work with UniEdit.
If you have questions, fedl free to contact the Duke University Humanities Computing Facility or
its agents.

Y ou can rearrange your own Language menus as you please. For example, you can promote your
favorite language keyboard to membership in the main menu by removing the SubMenul D= line,
or just “commenting it out” with a semicolon thus:

;SubMenuiD=8
and you can move it up or down the menu by changing its Languagel D#.

The [FontSize] section of the language keyboard *.INI file determines the actual height in pixels
of each font size used by UniEdit. See Changing the Default Font Size for Use in UniEdit.

(The lines Face=, CharSet=, Pitch=, and DeadKey= are no longer used in the UniEdit system.)

Setting Default Directories

Setting the Conversions Subdirectory

The“CONVERT” subdirectory holds code conversion utilities and filters, if during Setup you
selected the option to install “ Code Conversion Utilities.” If you did not select this option and you
wish to convert files from one coding standard to another, you will need to run Setup again and
select this option to install the necessary files.

The path to the “CONVERT” subdirectory is defined in the WINCALIS.INI file in the main
UniEdit subdirectory. It can be redefined to whatever path you choose by carefully editing the
linein the [WIinCALIS] section

Conversions= ...

Setting the Documents Subdirectory

The“DOCS” subdirectory can be used for your document text files. It is not essential to the
operation of UniEdit programs and may be deleted if you wish.

The path to the “DOCS” subdirectory can be redefined to whatever path you choose by carefully
editing the line in the [Cal Auth] section

Documents= ...

Setting the “Home” Directory

Y ou will not ordinarily need to change the program directory setting. But if you need to move the
entire UniEdit program directory and all its subdirectories to another drive or directory, you will
then need to change the “Home=" linein WINCALIS.INI, along with a number of other lines. If
UniEdit was installed in the default directory location “WINCALIS’ on drive C:, the “Home="
line would look like this.
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Home=C:\WINCALIS\

It is also important for network installations of UniEdit to be aware of the drive letter for the
“Home” and other directoriesin WINCALIS.INI. For example, it is sometimes the case with
installation on a network server that the DOS drive letter by which that server is known to alocal
workstation changes. If that happens, UniEdit will not function properly on the local workstation.
See Installing UniEdit on a Network.

Be careful in editing the “Home="line to retain the final backslash (reverse solidus).

Setting the Dictionaries Directory

The"DICTS" subdirectory holds any preinstalled on-line dictionaries.

The path to the "DICTS" subdirectory is defined in the WINCALIS.INI file in the main UniEdit
subdirectory. It can be redefined to whatever path you choose by carefully editing the line in the
[WIinCALIS] section

Dictionaries= ...

Linking to a Spelling Checker

The UniEdit Workstation Setup package includes a shareware Windows spelling checker
program, WinSpell 3.0a , which may be freely distributed.

WinSpell or another user-supplied spelling checker can be “linked” to UniEdit and UniEdit
menus by specifying the program name and the DOS path to it in the “ SpellChecker=" line in the
[WIinCALIS] section of WINCALIS.INI. For example:

SpellChecker =c:\winspell\winspell.exe

will enable the “Check Spelling” menu item in the UniEdit “ Utilities” menu. If that menu item is
selected, the WinSpell program will be executed.

The Default Character-to-Font Mapping File WCENT.INF

UniEdit always displays text in the typeface defined in the file “WCFNT.INF” in the UniEdit
program directory. This typeface is by default “Times New Roman” for the ANSI character set
(Unicode page 00) and extended L atin character set (Unicode pages 01-02, etc.). The default
typeface for use in UniEdit may be changed to Arial, Courier New, Fixedsys, M S Sans Serif (the
font you are reading in now! -- araster screen font which is preferred to TrueType fonts for
Windows Help because of its superior legibility at low resolutions such as on computer monitors),
or any other font available to the user.

Just edit the file “WCFNT.INF” with a plain text editor, such as the Windows Notepad. (Keep a
backup copy of the original file.) For example, to change the font for just the basic Windows
ANSI (Latinl) character set to Arial, thefirst line in the [FaceNames] section should be changed
to read:
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00=Arial.

In asimilar fashion the default font for any character set may be changed by editing the line(s)
for its corresponding code pagesin “WCFNT.INF.”

If you are currently running UniEdit, you will have to exit and restart UniEdit for the new
settings to take effect.

If you wish to make only atemporary change in your UniEdit font, you can leave the Notepad
with running in the background, with the WCFNT.INF file still open in it. Then after you have
finished using UniEdit, you can return to the Notepad and change the font back again.

See “Rearranging the Language Menus” for how to change the list of fonts displayed in the Fonts
dialog box.

(For how to change the ANSI font size, you will need to edit LATIN1.INI. See The Main
WinCadis Initialization File WINCALIS.INI.

Sample Portion of First Part of WCFNT.INF File

[FaceNames)
00=Times New Roman
01=Times New Roman
02=Times New Roman
03=Athens

04=Kiev

05=Td Aviv
06=Sahara

The latter part of the WCFNT.INF file contains “magnification” percentages for the fonts used
for each character set. E.g., the “Athens’ font for Greek is by default magnified to 110% of its
basic size.

Sample Portion of Second Part of WCFNT.INF File

(03]
Athens=110

[04]
Kiev = 120
Sofia= 120

[05]
Tel Aviv =120

[06]
Baghdad = 200
Sahara = 200
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New Configuration Dialog Box Coming Down the Pike:
Author Workstation WinCALIS Startup:
o Start Author Workstation WinCALIS in Text Conversion (*.CAL) mode
o Start Author Workstation WinCALIS in No Conversion (*.WCL) mode
Location of Files:
Main Scripts Directory: c:\wincalis\scripts
Shared Graphics Directory: c:\wincalis\graphics
Shared Multimedia Directory: c:\wincalissmitmedia
Conversion Utilities Directory: c:\wincalis\convert
Default Documents Directory: c:\wincalis\documents
Keyboard Arrangement (for display in keyboard help):
0 Backdash key (\) on top row, next to Backspace key
o Backslash key (\) on 2™ row from top, below Backspace key
0 Backdash key (\) on bottom row at extreme right, below Enter key
0 Backdash key (\) on bottom row at extreme left
L:[Language] Menu Top Language: English/W.Europe
(change by setting Default Language K eyboard)
Default Language Keyboard: LATINLINI
Author Fonts:
Author ANSI Font: Times New Roman
(change by setting WCFNT.INF 00= line below)
Author Font Size Pixel Height: 21
(change by setting Font Size Medium=below)
LATINZ.INI current settings:
Font Size Pixel Heights:
Tiny=12
Fine=16

Small=19
Medium=21
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Large=32

ExtraL arge=48

Huge=66

Fonts:

Font1=Times New Roman
Font2=Arial
Font3=Courier New
Font4=Fixedsys
Font5=MS Sans Serif
Font6=

WCFENT.INF current settings:

[FaceNames)
00=Times New Roman
01=Times New Roman
02=Times New Roman
03=Athens

04=Kiev

05=Td Aviv
06=Sahara

Defining Language Keyboard Files

The UniEdit program allows for the remapping of keyboard layouts and the display of non-
Roman character sets. The user may select a keyboard mapping and a character set from the pull-
down "L:[anguage]” menu.

Once alanguage is selected, choosing "keyboard" from the "Help" menu will display the layout of
the currently selected font. Accents and key combinations for producing characters are also

displayed.

In order to make a character set and a keyboard layout available to the user, three files are

required.
1 LANGUAGENAME.INI
2. LANGUAGENAME.WCK

3. The appropriate character font, contained in font files such as FONTFILE.FON
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Font Files

Font files contain character setsin aformat which can be displayed in Windows.

They should be placed in the subdirectory \FONTS located below the Windows 95 directory.

UniEdit comes bundled with all the fonts necessary to display all character sets.

Language Keyboard ".INI" Files

There is afile ending with the extender .INI for each UniEdit language keyboard. The .INI fileis
theinitialization file for a particular language keyboard, which specifies the keyboard
arrangement, name, fonts, on-line dictionary and other attributes of the language keyboard.

It must be placed in the UniEdit home directory--by default \WINCALIS.

You may edit .INI files with a plain text editor such as the Windows Notepad or the DOS EDIT
program. For example, you may wish to specify a different on-line dictionary or a new font
available for a keyboard. Be sure you understand the particular structure documented bel ow.

The following file "RUSSIANS.INI" is an example of such afile

Comments on the file are preceded with a semicolon (;)

[Language]

Name=Russian-Standar d

; The name of the language keyboard that

;appears in the "L:[Language]” pull-down menu.
Submenul D=8

; This value determines which submenu, if any, the
;keyboard appearsin, in this case "Cyrillic"

Face=WC2Uni04
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;Not currently used.

RightL eft=0

;The zero value for RightLeft indicate the

;Character set is written from left-to-right.

;A value of "1" means right-to-left.

Char Set=0

;Thisvalueis either zero, 2, or 255 - ANSI, Symbol or OEM
;(Not currently used)

Keyboar d=RussianS

;Thisis the DOS filename of the WCK file

;which specifies the keyboard arrangement.

L anguagel D=790

; This number must correspond with the ID number
;specified for the RussianS keyboard in the WINCALIS.INI
;main initialization file. The specific number assigned

;will determine the order of the name in the

;L[anguage]: menu

; The highest possible value for this number is 999.

;See “Rearranging the Language Menus’

Pitch=2

; This value indicates a proportional font.

;Zero would indicate afixed font. (Not currently used.)
DeadK ey=
;(Not currently used--overstrike (dead) key is aways F2
Font1=Kiev
Font2=M oscow
Font3=Sofia
; Typefaces available for use with this keyboard and character

;set are specified here. They will appear as choices when the
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;user selects the Set Font menu option in the WinCALIS

:Author Format menu.

[FontSize]

Tiny=12

Fine=16

Small=19

Medium=21

Large=32

Extral arge=48

Huge=66

;The adjectives on the |eft are the names given

;to font point sizesin WinCALls. The numeric values

;on the right indicate the pixel height for each size.

[Dictionary]

DictFile=wcruseng.dic

I ndexFile=wcruseng.idx

;These lines specify the filenames of the on-line dictionary

;and itsindex file to be accessed in the directory defined in the
;Dictionaries= line of WINCALIS.INI when the user presses F5 or selects
;the menu option Tools, Look Up Word while "Russian-Standard"
;isthe current language keyboard. If no filenames are specified,
;the default dictionary with the filenames WINCALIS.DIC and
sWINCALIS.IDX will be used instead.

;See How to Create Y our Own On-line Dictionary

;and Setting the Dictionaries Directory

“\WCK” Files

(NOTE: Some of the information below is now obsolete.)
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Thisis abinary format file which specifies which keystrokes produce which characters.

It cannot be edited directly. To createa* .WCK file you must edit a text file with the same name
and the extension *. MAP. After thisfileisedited it is processed into the binary file format of a
* WCK file.

After editing such afile select the “ Create Keyboard” option from the “File” pull-down menu in
UniEdit. The“*.MAP’ filewill be compiled into a“* . WCK” file.

Whilethe “.MAP” fileis not needed to map characters once the “.WCK?” file is created, you
should save it in case you wish to make changes to the keyboard mapping.

The map file consist of several headings which are written inside of square brackets. ([ ])

Below each of these topics are the actual characters OR their numeric character values, enclosed
in curly braces ({ }), affected by the headings under which they are listed.

Comments can be included in a“.MAP” file by preceding them with a semicolon ( ;).
Text which appears on aline after a semicolon will be ignored.

If you wish to remap a square brace ([, ] ), acurly brace ({, } ), or asemicolon ( ; ) you must use
the character values for these characters rather than the characters themselves.

Tomakea“.MAP” file as readable as possible it is recommended that you list each combination
of characters on asingleline. Thisisnot required.

A simple debugging feature in the program which compiles your “.MAP’ fileinto a“.WCK?” file
will give an error message telling you which line of the “.MAP” file caused a problem.

Because creating a new “.WCK” file overwrites the previous one (unless you give it a new name)
it is recommended that you keep backups.

Also, itisagood ideato develop “.MAP’ filesincrementally, and convert them to “.WCK?” files
regularly. This process takes only afew seconds and will make pinpointing errors a simple task.

Note that if you use the UniEdit you can type in character from foreign character sets instead of
their character values.

This is not recommended because such files appear unintelligible when other fonts are used to
display them or when they are edited with DOS-based word processors.

At the end of the conversion process a message box will appear to confirm that the “.WCK?” file
has been successfully generated.

Click on one of the following topics for more information on the contents of a“.MAP”’ file.

All of the headings listed below are required in every “.MAP’ file, even if they are not used, with
the exception of [Position]

The [MAP] heading

The [ALPHA] heading
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The [PUNCTUATION] heading

The [SPACE] heading

The [DIGIT] heading

The [VOWEL] heading

The [UPPER/LOWER] heading

The [ACCENT/NOACCENT] heading
The [POSITION] heading

The [ACCENTS] heading

The [ENDV1] heading

Sample “.MAP” File HEBREWI.MAP

;hebrewi.map - Israeli keyboard

[map]

t {05D0} ;alef
c{05D1} ;bet
d{05D2} ;gime
s{05D3} ;dalet

v {05D4} ;he

u {05D5} ;vav

z {05D6} ;zayin

j {05D7} ;het

y {05D8} ;tet

h {05D9} ;yod

| {05DA} ;find kaf

f {05DB} ;kaf

k {05DC} ;lamed

0 {05DD} ;final mem
n {05DE} ;mem

i {05DF} ;final nun
b {05EQ} ;nun

x {05E1} ;samekh
g{05E2} ;ayin
{003B}{05E3} ;final pe ;mapped to semicolon
p {05E4} ;pe

. {O5E5} ;final tsadi
m {O5E6} ;tsadi

e {05E7} ;qof

r { O5E8} ;resh
a{05E9} ;shin

, {O5EA} ;tav

: {05C3} ; Hebrew punctuation sof pasuq
/.

q/

W,

S{05B0} ;HEBREW POINT SHEVA



Chapter 7: Configuring and Customizing UniEdit 97

0 {05B1} ;HEBREW POINT HATAF SEGOL

| {05B2} ;HEBREW POINT HATAF PATAH

B {05B3} ;HEBREW POINT HATAF QAMATS
A {05B4} ;HEBREW POINT HIRIQ

F{05B5} ;HEBREW POINT TSERE

C{05B6} ;HEBREW POINT SEGOL

H {05B7} ;HEBREW POINT PATAH

D {05B8} ;HEBREW POINT QAMATS

E {05B9} ;HEBREW POINT HOLAM

G {05BB} ;HEBREW POINT QUBUTS
J{05BD} ;HEBREW POINT METEG

K {05BE} ;HEBREW PUNCTUATION MAQAF
L {05BF} ;HEBREW POINT RAFE

M {05C0} ;HEBREW PUNCTUATION PASEQ;;HEBREW POINT PAS
N { FFFF}

P{FFFF}

Q{FFFF)

R {FFFF}

T {FFFR}

U {FFFF}

V {FFFF}

W {FFFF}

X {FFFF}

Y {FFFF}

Z {FFFF}

[alpha]

;Unicode 1.1; WinCALIS 1.0 draft Hebrew; Hebrew Text CALIS codes; description
{05B0} ;HEBREW POINT SHEVA

{05B1} ;HEBREW POINT HATAF SEGOL

{05B2} ;HEBREW POINT HATAF PATAH

{05B3} ;HEBREW POINT HATAF QAMATS

{05B4} ;HEBREW POINT HIRIQ

{05B5} ;HEBREW POINT TSERE

{05B6} ;HEBREW POINT SEGOL

{05B7} ;HEBREW POINT PATAH

{05B8} ;HEBREW POINT QAMATS

{05B9} ;HEBREW POINT HOLAM

{05BB} ;HEBREW POINT QUBUTS

{05BC} ;HEBREW POINT DAGESH OR MAPIQ;;HEBREW POINT DAGESH
{05BD} ;HEBREW POINT METEG

{05BE} ;HEBREW PUNCTUATION MAQAF

{05BF} ;HEBREW POINT RAFE

{05C0} ;HEBREW PUNCTUATION PASEQ;;HEBREW POINT PAS
{05C1} ;HEBREW POINT SHIN DOT

{05C2} ;HEBREW POINT SIN DOT

{05C3} ;HEBREW PUNCTUATION SOF PASUQ

{05D0} ;alef

{05D1} ;bet

{05D2} ;gimel

{05D3} ;dalet

{05D4} ;he

{05D5} ;vav

{05D6} ;zayin
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{05D7} ;het

{05D8} ;tet

{05D9} ;yod

{05DA} ;final kaf

{05DB} ;kaf

{05DC} ;lamed

{05DD} ;final mem

{O5DE} ;mem

{O5DF} ;final nun

{O5EQ} ;nun

{05E1} ;samekh

{O5E2} ;ayin

{O5E3} ;final pe

{O5E4} ;pe

{O5E5} ;final tsadi

{O5E6} ;tsadi

{O5E7} ;qof

{05E8} ;resh

{05E9} ;shin

{05EA} ;tav

{05F0} ;HEBREW LIGATURE YIDDISH DOUBLE VAV

{05F1} ;HEBREW LIGATURE YIDDISH VAV YOD

{05F2} ;HEBREW LIGATURE YIDDISH DOUBLE YOD

{05F3} ;HEBREW PUNCTUATION GERESH

{05F4} ;HEBREW PUNCTUATION GERSHAYIM

{FB1E} ;HEBREW POINT JUDEO-SPANISH VARIKA;HEBREW POINT VARIKA;
{FB1F} ;HEBREW LIGATURE YIDDISH YOD YOD PATAH; [05D9] & [05D9] & [05B7]
{FB20} ;HEBREW LETTER ALTERNATIVE AYIN;[05E2]

{FB21} ;HEBREW LETTER WIDE ALEF;[05D0]

{FB22} ;HEBREW LETTER WIDE DALET;[05D3]

{FB23} ;HEBREW LETTER WIDE HE;[05D4]

{FB24} ;HEBREW LETTER WIDE KAF;[05DB]

{FB25} ;HEBREW LETTER WIDE LAMED;[05DC]

{FB26} ;HEBREW LETTER WIDE FINAL MEM;[05DD]

{FB27} ;HEBREW LETTER WIDE RESH;[05ES]

{FB28} ;HEBREW LETTER WIDE TAV;[05EA]

{FB29} ;HEBREW LETTER ALTERNATIVE PLUS SIGN;[002B]
{05CA} ;HEBREW LETTER SHIN WITH SHIN DOT;[05E9] & [05C1]
{05CB} ;HEBREW LETTER SHIN WITH SIN DOT;[05E9] & [05C2]
{FB2C} ;HEBREW LETTER SHIN WITH DAGESH AND SHIN DOT;[05E9] & [05BC] &
[05C1]

{FB2D} ;HEBREW LETTER SHIN WITH DAGESH AND SIN DOT;[05E9] & [05BC] &
[05C2]

{FB2E} ;HEBREW LETTER ALEF WITH PATAH;[05DQ] & [05B7]
{FB2F} ;HEBREW LETTER ALEF WITH QAMATS;[05D0] & [05B8]
{FB30} ;HEBREW LETTER ALEF WITH MAPIQ;[05D0Q] & [05BC]
{05CC} ;HEBREW LETTER BET WITH DAGESH;[05D1] & [05BC]
{FB32} ;HEBREW LETTER GIMEL WITH DAGESH;[05D2] & [05BC]
{FB33} ;HEBREW LETTER DALET WITH DAGESH;[05D3] & [05BC]
{FB34} ;HEBREW LETTER HE WITH MAPIQ;[05D4] & [05BC]
{FB35} ;HEBREW LETTER VAV WITH DAGESH;[05D5] & [05BC]
{FB36} ;HEBREW LETTER ZAYIN WITH DAGESH;[05D6] & [05BC]
{FB38} ;HEBREW LETTER TET WITH DAGESH;[05D8] & [05BC]
{FB39} ;HEBREW LETTER YOD WITH DAGESH;[05D9] & [05BC]
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{FB3A} ;HEBREW LETTER FINAL KAF WITH DAGESH;[05DA] & [05BC]
{05CF} ;HEBREW LETTER KAF WITH DAGESH;[05DB] & [05BC]
{FB3C} ;HEBREW LETTER LAMED WITH DAGESH;[05DC] & [05BC]
{FB3E} ;HEBREW LETTER MEM WITH DAGESH;[05DE] & [05BC]
{FB40} ;HEBREW LETTER NUN WITH DAGESH;[05E0] & [05BC]
{FB41} ;HEBREW LETTER SAMEKH WITH DAGESH;[05E1] & [05BC]
{FB43} ;HEBREW LETTER FINAL PE WITH DAGESH;[05E3] & [05BC]
{05CD} ;HEBREW LETTER PE WITH DAGESH;[05E4] & [05BC]
{FB46} ;HEBREW LETTER TSADI WITH DAGESH;[05E6] & [05BC]
{FB47} ;HEBREW LETTER QOF WITH DAGESH;[05E7] & [05BC]
{FB48} ;HEBREW LETTER RESH WITH DAGESH;[05ES] & [05BC]
{FB49} :HEBREW LETTER SHIN WITH DAGESH;[05E9] & [05BC]
{05CE} ;HEBREW LETTER TAV WITH DAGESH;[05EA] & [05BC]
{FB4B} ;HEBREW LETTER VAV WITH HOLAM;[05D5] & [05B9]
{FBA4C} ;HEBREW LETTER BET WITH RAFE;[05D1] & [05BF]

{FB4D} ;HEBREW LETTER KAF WITH RAFE;[05DB] & [05BF]

{FB4E} ;HEBREW LETTER PE WITH RAFE;[05E4] & [05BF]

{FB4F} ;HEBREW LIGATURE ALEF LAMED;[05D0] & [05DC]

[punctuation]

|@HSWN&* ()_+-=\',J|"<>?
{003B}{005B}{005D}{007B}{007D} ;i.e.;[1{}
{05C3} ;Hebrew punctuation sof pasuq

[space]
{0020} ; {32}

[digit]
1234567890

[vowdl]
[upper/lower]

[accent/noaccent]
{FB2A}{05E9} ;shin shindot
{FB2B}{05E9} ;shin sindot
{FB31}{05D1} ;bet dagesh
{FB44}{ 05E4} ;pe dagesh
{FB4A}{05EA} ;tav dagesh

[Position]

;isolate, initial, medial, findl;
{05D0}{05D0}{ 05D0} { 05DO0} ;alef
{05D1}{05D1}{05D1}{05D1} ;bet
{05D2}{05D2}{05D2}{05D2} ;gimel
{05D3}{05D3}{05D3}{05D3} ;dalet
{05D4}{05D4}{ 05D4}{ 05D4} ;heh
{05D5}{ 05D5}{ 05D5} { 05D5} ;vav
{05D6}{05D6} { 05D6}{ 05D6} ;zayin
{05D7}{05D7}{05D7}{05D7} ;het
{05D8}{05D8}{05D8}{ 05D8} ;tet
{05D9}{ 05D9}{05D9}{05D9} ;yud
{05DB}{05DB}{05DB}{05DA} ;kaf
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{05DC}{05DC}{05DC}{ 05DC} ;lamed
{05DE}{ 05DE}{ 05DE}{ 05DD} ;mem
{ O5E0}{ 05E0} { 05E0} { 05DF} ;nun

{ O5E1}{ 05E1}{ 05E1}{ 05E1} ;sameh
{ O5E2}{ 05E2}{ 05E2}{ 05E2} ;ayin

{ O5E4}{ 05E4}{ 05E4}{ 05E3} ;peh

{ O5E6}{ 05E6} { 05E6} { 05E5} ;tsadi
{05E7}{ 05E7}{ 05E7}{ 05E7} ;qof

{ O5E8}{ 05E8} { 05E8} { 05E8} ;resh

{ 05E9}{ 05E9} { 05E9} { 05E9} ;shin
{O5EA}{O5EA}{ OSEA}{ OSEA} ;tav

[accents]

shindot ‘ ; {05C1}
sindot ~ ; {05C2}
dagesh, ; {05BC}

[shindot]
{05E9}{FB2A} ;shin

[sindot]
{05E9}{FB2B} ;shin

[dagesh]
{05D1}{FB31} ;bet

{O5E4}{FB44} ;pe
{O5EA}{FB4A} ;tav

[endv1]

“ MAP” File Heading [MAPPING]
This heading is used to map or remap characters to the keyboard.
Mappings arelisted in pairs.
First, the keyboard character which is to be replaced is listed.
Second, the character which will replaceit is listed.
For example
[MAPPING]
af
{0064} {009B}
As specified above, pressing the “a” key on the PC keyboard will no longer produce an “a’ but

In the same way, pressing the “d” key (character value 0064) will produce character 009B
instead.
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Y ou may specify characters by entering them directly or by their character values enclosed in
curly braces.

Separate each entry with aleast one blank space.
Note that the first value or character must be one of the keys located on the PC keyboard.

Depending on what font is used to display these files, you may see Cyrillic, Greek, or Roman
characters, among others.

Files created using a keyboard mapping intended for Russian will look like garbage if they are
displayed with another font.

When users select the keyboard help feature in UniEdit, the keyboard window will display the
characters as you have remapped them.

“.MAP” File Heading [ALPHA]
This heading is used to list all of the characters in afont which are alphabetic.

Thisfeatureis useful because it allows the script author to write diagnostic messages based on the
presence or absence of an alphabetic character.

Characters may be listed under this heading by entering them directly or by typing in their
character value enclosed in curly braces.

“.MAP” File Heading [PUNCTUATION]
This heading is used to specify all of the charactersin afont which are used for punctuation.

WinCALIs uses this information to determine if a student response is correct or incorrect based on
the improper use of punctuation.

Characters under this heading may be entered directly or by listing their character value in curly
braces.

“ MAP” File Heading [SPACE]
Specify what character (or possibly characters) is used as the space character.
WinCALIs uses this information to ignore multiple spaces between words in a student response.
This character must be listed by its character value. (You can’t display an empty character!)

This character is nearly always {0020} .

“.MAP” File Heading [DIGIT]
Specify which characters are numeric.

At thistime this feature is not used. Potentially it could be used to distinguish answers which
contain numeric characters from other answers. Call usif you need this for your courseware
development.

Although unused, every “.MAP’ file must contain this heading. No characters need follow it.



102

“.MAP”

“.MAP”

“.MAP”

“.MAP”

Characters can be entered directly or by listing their character value inside of curly braces.

File Heading [VOWEL]

This heading is only useful for Chinese at present. If you feel that the ability of WinCALIS to
distinguish consonants and vowels would be useful for some other language, this feature could
easily be added.

This heading must appear in all

Characters may be entered directly or by listing their character value inside of curly braces.

File Heading [UPPER/LOWER]

The information in this and the following section is no longer used by WinCALIs/UniEdit. The
global information file WINCALISWGI (q.v.) is used instead.

This heading is used to list uppercase/lowercase equivalents.

Thisinformation is used by WinCAaLIs to determine whether case is significant in judging student
responses.

Characters under this heading are listed in pairs.
First the upper case character or its character value in curly braces.

Second the lower case character or its character value in curly braces.

File Heading [ACCENT/NOACCENT]
This heading is used to list accented/unaccented equival ents.

Thisinformation is used by WinCAaLIS to determine whether the proper use of accentsis
significant in judging student responses.

Characters under this heading are listed in pairs.
First the accented character or its character value in curly braces.

Second the unaccented character or its character value in curly braces.

File Heading [POSITION]

Thisisthe only optional headingina“

It is used to specify what characters are affected by their position in aword.
Characters are listed in sets of four in the following order:
{[independent]}{{initial]} { [medial]}{[final]}

Characters may be listed by entering the characters themselves or by listing their character values
in curly braces.

This feature is used with the UniEdit Persian and Arabic fonts.
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“.MAP” File Heading [ACCENTS]
This heading is used to precede alisting of all of the names given to diacritic marks.

After the name of the diacritic, list the single character which will be used in combination with
the overstrike key F2 to form an accented character.

Diacritic names must not contains spaces.

For example:

[ACCENTS]

umlaut "

nonsense { 0078}

Two accent keys are now defined with the names “umlaut” and “nonsense.”

When keyboard help is selected from within UniEdit, a keyboard will display with the double
guote (") and character 0078 - alowercase “x” in pale blue.

This indicates to the user that these keys can be used in combination with the dead key to produce
anew character.

Beneath the [ACCENTS] heading each accent is listed a second time as a heading itself.

Following thisis alisting of all characters which can be typed and then altered or changed
completely with the overstrike key/accent key combination.

For example:
[umlaut]
a{00E4}
{0075} {00FC}
[nonsense]

az

{0064} b

As specified above, the key combination “a’ + the dead key + the “umlaut” accent key (adouble
guote as defined in the [accents] section) will produce character 00E4 - an “a’ with two dots over
it.

In the same way, alower case “u” (character 0075) becomes a“u” with two dots over it
(character 00OFC).

The “nonsense” accent key changes alower case “a’ into alower case“z.”

Character 0064 (alower case “d") becomes alower case “b.”
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With the keyboard help window open the user can click with the secondary mouse button on an
accent key to see which keys it affects and what characters they produce. The selected accent key
turns red and the affected keys display in green.

According to the examples above, if the user opens the keyboard window and clicks with the
secondary mouse button the “nonsense” accent key the lower case “X” turns from pale blue to
green. Thetwo charactersit affects - the“a” and the “d” areredisplayed asa“z” and a“b.”

Clicking on or pressing the “umlaut” accent key (the double quote) changes the “a” and the “u”
to umlauted characters.

All listings under accent headings must be paired - original character and character to be
displayed after the overstrike key/accent key combination is struck.

Characters may be entered directly or listed by character value within curly braces.

“ MAP” File Heading [ENDV1]

No characters are listed beneath this heading. It simply marks the end of the file. However,
there should be at least one new line after the heading.

The UniEdit Global Information File WINCALIS.WGI

The binary global information file WINCALIS.WGI in UniEdit replaces much of the language-
specific information which was formerly in the individual language keyboard * WCK files
WinCAaLIs 1x regarding what constitutes punctuation, capitalization (upper-and-lower case
relationships), and accented-unaccented character relationships. WinCALIS now is ableto
evaluate these linguistic and orthographic characteristics properly, no matter which keyboard is
currently selected.

Note that the [upper/lower] section of WINCALIS.WGI is used for case-independent searchesin
the Find and Replace dialog boxes. It could also be used in the future for sorting purposes, along
with the [accent/noaccent] section.

The name WINCALISWGI is arbitrary and is identified to the UniEdit system by the
“GlobalInfoFile=" linein WINCALIS.INI. By default, thefile is called WINCALISWGI and is
in the main program directory.

WINCALIS.WGI is created from its ASCII text counterpart WINCALIS.INF by opening
WINCALIS.INF in the Scratchpad as an ASCII/ANSI file, then clicking on the Create Global
File menu item in the File menu. WINCALIS.INF isincluded in the UniEdit Workstation, for
browsing and editing on the part of users. Please notify the Humanities Computing Facility of
Duke University if you find errors or omissionsin thefile.

Samples entries under each subheading in WINCALISWGI

[non-spacingmarks] (unused)
[punctuation]

{0021} ;!

{0022} ;"

{0023} ;#

{0024} ;%
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{037E} ;Greek question mark (semicolon)
{05C3} ;Hebrew

{060C} ;Arabic comma

{061B} ;Arabic semicolon

{061F} ;Arabic question mark

{066A} ;Arabic percent sign

{06D4} ;Arabic period (Fars period) (Urdu)?
{1255} ;Ethiopian (Amharic) wordspace
{1256} ;Ethiopian (Amharic) comma

[upper/lower]
Aa
Bb
Cc
Dd
Ee

{OODC}{00FC} ;U diaeresis u diaeresis
{OODD}{00FD} ;Y acute y acute
{OODE}{00FE} ;capital thorn small thorn
{OODF}{00DF} ;esszed esszed
{0100}{0101} ;A macron amacron
{0102} {0103} ;A breve abreve

{0104} {0105} ;A ogonek aogonek
{0106}{ 0107} ;C acute c acute

{0108}{ 0109} ;C circumflex c circumflex

[accent/noaccent]

{00CO} A ;A grave
{00C1} A ;A acute
{00C2} A ;A circumflex
{00C3} A ;Atilde

{FB44}{ O5E4} ;pe dagesh

{FB4A}{05EA} ;tav dagesh

{FD15}{00EA} ;e circumflex grave e circumflex
{FD39}{00EA} ;e circumflex acute e circumflex
{FD60}{ 00EA} ;e circumflex macron e circumflex
{FD61}{00EA} ;e circumflex hacek e circumflex

tendvl]
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Deleting Nonessential Files to Save on Disk Space

When you install UniEdit, it installs *.INI, *.MAP, and * WCK files for all available languages
into your program directory by default. The Delete Language menu item in the L:[Language]
menu deletes languages from the listing in the menu, but it does not delete any files from your
disk.

If you need to economize on disk space, after deleting alanguage from your menu, you may also
use the Windows File Manager, DOS commands, or another tool to deleteits *.INI, *.MAP, and
* WCK files from your hard disk, or move them to a backup storage location.

* MAP files are simply the text versions of binary keyboard * \WCK files, which are those used by
UniEdit. If you do not anticipate the need to edit or add any keyboard file, you may delete all the
* MAP files from your system. See the section below for other nonessential files you may delete
to conserve disk space.

If necessary, you can always recover deleted files by reinstalling the UniEdit Workstation.

Files Installed During UniEdit Setup

The following list shows all the files installed during a complete setup. Essential files are marked
with an asterisk. Some other files, usually noted, may be essential to your specific needs.

UniEdit Program directory and subdirectories:

amharic.ini ;you need an *.ini file and calgloss.hip ;(Part of Users Manual)
*.wck file cangjie.ini
amharic.wck ;for each language keyboard centasia.ini
you use centasiawck
amharic.map ;*.map files are only needed centasia.map
if you modify chinese.ini
arabicc.ini ‘;or create keyboard (See croatian.ini
arabicc.map ;Defining Language croatian.wck
Keyboard Files) croatian.map
arabicc.wck czech.ini
arabicx.ini czech.wck
arabicx.map czech.map
arabicx.wck dutch.ini
arabusg.ini dutch.wck
arabusg.map dutch.map
arabusg.wck eeur.ini
armenian.ini eeur.wck
armenian.wck eeur.map
armenian.map english.ini
belarus.ini english.wck
belarus.wck english.map
belarus.map formsymb.ini
bopomofo.ini formsymb.wck
bopomofo.map formsymb.map
bopomoafo.wck french.ini
bug.txt french.wck
bulgaria.ini french.map
bulgaria.wck gencyril.map
bulgariamap generic.map
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georgian.ini
georgian.wck
georgian.map
german.ini
german.wck
german.map
greekcal.ini
greekcal .wck
greekcal .map
greekpc.ini
greekpc.wck
greekpc.map
hausa.ini
hausa.wck
hausa.map
hebrewi.ini
hebrewi.map
hebrewi.wck
hebrewk.ini
hebrewk.map
hebrewk.wck
hebrewt.ini
hebrewt.map
hebrewt.wck
hebrewu.ini
hebrewu.map
hebrewu.wck
hiragana.ini
hiragana.map
hiragana.wck
ibm-pc.ini
ibm-pc.wck
ibm-pc.map
ipa.ini
ipawck
ipa.map
*irreg.idx
*irreg.ptr
italian.ini
italian.wck
italian.map
kanjicj.ini
katakana.ini
katakana.map
katakana.wck
koreank.ini
koreank.map
koreank.wck
koreanm.ini
koreanm.map
koreanm.wck
koreans.ini
koreans.map
koreans.wck

;essential for CIK (Chinese-
;Japanese-K orean) module

koreanu.ini
koreanu.map
koreanu.wck
korhanja.ini
latin.ini
latin.wck
latin.map
latinl.ega
*latinl.ini

*|atinl.wck
latinl.map
latvian.ini
latvian.wck
latvian.map
lithuan.ini
lithuan.wck
lithuan.map
macedon.ini
macedon.wck
macedon.map
magyar.ini
magyar.wck
magyar.map
*mip.dat
*mip.exe

mip.hlp
*miptt.exe
miptt.hlp
mongol.ini
mongol.wck
mongol.map
pashto.ini
pashto.map
pashto.wck
persianc.ini
persianc.map
persianc.wck
persianp.ini
persianp.map
persianp.wck
persianx.ini
persianx.map
persianx.wck
*pinyin.idx
pinyin.map
*pinyin.ptr
pinyin.wck
polish.ini
polish.wck
polish.map
portug.ini
portug.wck

;thisis sine quanon
keyboard

;Multilingual Printer
Program

;TrueType Printer Program

:essential for CIK module
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portug.map
readme.txt
romaji.ini
romaji.map
romaji.wck
romajinc.ini
romanian.ini
romanian.wck
romanian.map
russianc.ini
russianc.wck
russianc.map
russians.ini
russians.wck
russians.map
russtech.ini
russtech.wck
russtech.map
scandin.ini
scandin.wck
scandin.map
serbian.ini
serbian.wck
serbian.map
sindhi.ini
sindhi.map
sindhi.wck
*gis2wc2.tab
dlovak.ini
slovak.wck
dovak.map
spanish.ini
spanish.wck
spanish.map
tagalog.ini
tagalog.wck
tagalog.map
thai.ini
thai.wck
thai.map
tranglit.ini
tranglit.wck
translit.map
turkish.ini
turkish.wck
turkish.map
ukraine.ini
ukraine.wck
ukraine.map
*uni 2fntL.wcf

* uni 2fnt2.wcf
*uni2fnt3.wcf
* uni 2fnt4.wcf

:essential for CIK module

;Unicode-font mapping
tables

*uni 2fnt5.wcf
*uni 2fnt6.wcf
uni2gjis.tab
*unicjcmp.inx
*unicjjpn.inx
*unicjsmp.inx
unigrep.exe
unisort.exe
urdu.ini
urdu.map
urdu.wck
vietname.ini
viethame.wck
viethame.map
*wechn.dll

*wcechnbpw.dat

*wcechndsk.dic

*wcchnmem.dic

*wcechnptr.dic
*wedef.dll
*wcfnt.inf

*wcjpn.dll
*wcjpn.dic
*wcjpnhst.dic
*wckey.dll
*wekrn.dll
*wekrn.dic
*wekrn.idx
*wekrn.wcf
*wer2l.dll
*wer2l .wcf
*wertw.dll
*wetxt.dll
wincalis.inf

wincalis.wci
*wincalis.wgi

*wincalis.ini

yiddish.ini
yiddish.map
yiddish.wck
yoruba.ini
yoruba.wck
yoruba.map

:essential for CIK module

:See readme.txt

;essential *.dll Dynamic
Link Libraries
:essential for CIK module

;See The Default Character-
to-Font Mapping File
WCFNT.INF

:essential for CIK module

:essential for CIK module
:essential for CIK module
:essential for CIK module

;essential for Arabic script

:See The UniEdit Global
Information File
WINCALISWGI

:See The UniEdit Global
Information File
WINCALISWGI

:See The Main UniEdit
Initialization File
WINCALIS.INI
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convert\convtnd.rec

convert\lst2tab3.exe

convert\lst2tab5.exe

convert\readme.txt
convertiwc2& 1004.|st

convert\wc2& 1004.tab
convert\wc2& 1040.|st

convertiwc2& 1040.tab
convert\iwc2& 1041.Ist
convertiwc2& 1041.tab
convert\iwc2& 1043.1st
convertiwc2& 1043.tab
convert\iwc2& 1250.Ist
convertiwc2& 1250.tab
convert\iwc2& 1251 .Ist
convert\wc2& 1251.tab
convert\wc2& 1252.Ist
convert\wc2& 1252 .tab
convert\wc2& 1253.Ist
convert\wc2& 1253.tab
convert\wc2& 1254.|st
convert\wc2& 1254.tab
convert\iwc2& 1255.Ist
convert\wc2& 1255.tab
convert\wc2& 1256.1st
convert\wc2& 1256.tab
convert\wc2& 8hit.doc
convert\wc2& 8hit.exe
convert\wc2& ansi.Ist
convert\wc2& ansi.tab
convert\wc2& brav.Ist
convert\wc2& brav.tab
convert\wc2& brov.lst
convert\wc2& brov.tab
convert\wc2& cae.lst
convert\wc2& caletab
convert\iwc2& calg.lst
convert\iwc2& calg.tab
convert\wc2& calh.lst
convert\wc2& calh.tab
convert\iwc2& calp.lst
convert\iwc2& calp.tab
convert\wc2& calr.lst

;optional
conversion
filters

;only *.tab
filesare
essential
;unless you
want to edit
or create
New ones

* st files
are text
versions

;of * tab files
;See Eight-
bit Code
Conversions

convert\wc2& calr.tab
convert\wc2& d437.Ist
convert\wc2& d437.tab
convert\iwc2& d850.Ist
convert\wc2& dg50.tab
convert\iwc2& d852.Ist
convert\wc2& dgs2.tab
convert\wc2& d8s5.Ist
convert\wc2& dgs5.tab
convert\wc2& d857.Ist
convert\wc2& dgs7.tab
convert\iwc2& d860.Ist
convert\wc2& d860.tab
convert\iwc2& dg61.Ist
convert\wc2& dg61.tab
convert\wc2& d863.Ist
convert\wc2& dg63.tab
convert\iwc2& dg864.Ist
convert\wc2& dg64.tab
convert\wc2& d865.Ist
convert\wc2& dg65.tab
convert\wc2& d866.Ist
convert\wc2& dg66.tab
convert\iwc2& d869.Ist
convert\wc2& dg69.tab
convert\iwc2& go74.1st
convert\iwc2& go74.tab
convert\wc2&isol.Ist
convert\wc2&isol.tab
convert\wc2& iso2.Ist
convert\wc2&iso2.tab
convert\wc2& iso3.Ist
convert\wc2&iso3.tab
convert\wc2& iso4.Ist
convert\wc2& isod.tab
convert\wc2& isob.Ist
convert\wc2&iso5.tab
convert\wc2& isob.Ist
convert\wc2&iso6.tab
convert\wc2& iso7.Ist
convert\wc2&iso7.tab
convert\wc2& iso8.Ist
convert\wc2&iso8.tab
convert\wc2& iso9.Ist
convert\wc2&is09.tab
convert\wc2& koi7.1st
convert\wc2& koi7.tab
convert\wc2& macc.Ist
convert\wc2& macc.tab
convert\wc2& pcmd.|st
convert\iwc2& pcmd.tab
convert\wc2& vsci .l st
convert\wc2& vsci.tab
convert\wc2& wcla.lst
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convertiwc2& wclatab
convertiwc2& wclb.lst
convertiwc2& wclb.tab
convertiwc2& welc.lst
convertiwc2& welc.tab
convertiwc2& wcle.lst
convertiwc2& wcletab
convertiwc2& wcelg.lst
convert\iwc2& wclg.tab
convertiwc2& wclj.lst
convert\wc2& wclj.tab
convertiwc2& welk.lst
convertiwc2& welk.tab
convertiwc2& wclv.Ist
convertiwc2& wclv.tab
convert\wincalis.wci
convert\wincalis.dir
convert\cjk\b5& weuni.lst

convert\cjk\b5& weuni.tab

convert\cjk\cmp2smp.Ist
convert\cjk\cmp2smp.tab

convert\cjk\dct2uni.exe
convert\cjk\dct2uni.Ist
convert\cjk\dct2uni.tab
convert\cjk\east2uni.exe
convert\cjk\eucj& uni.Ist
convert\cjk\eucj& uni.tab
convert\cjk\gb& weuni.lst
convert\cjk\gb& weuni.tab
convert\cjk\ks& wcuni.lst
convert\cjk\ks& wcuni.tab
convert\cjk\Ist2tabd.exe
convert\cjk\Ist2tabe.exe
convert\cjk\lst2tabh.exe
convert\cjk\readmeb5.doc
convert\cjk\readmegb.doc
convert\cjk\readmes.doc
convert\cjk\gis& uni.lst
convert\cjk\gjis& uni.tab
convert\cjk\gis2wc2.exe
convert\cjk\smp2cmp.Ist
convert\cjk\smp2cmp.tab
convert\cjk\u10& ull.Ist
convert\cjk\u10& ull.tab
convert\cjk\uni2east.exe
convert\cjk\wc2& east.exe
convert\cjk\wc2& east.doc

;CIK
(Chinese-
Japanese-
;Korean)
related
conversion
;filters (See
;Sixteen-bit
Code
Conversions)

convert\cjk\wca& wch.exe
convert\cjk\wca& wcb.tab
convert\cjk\wca2wcb.tab
convert\cjk\wch2wca.tab
docs\readme.txt
docswincalis.dir
docs\wincalis.wci

Windows System directory:

*c:\windows\system\ctl 3d.dl|

c:\windows\system\wc03_14a.ttf

c:\windows\system\wc03_14a.fot
c:\windows\system\wc04_ 14w ttf
c:\windows\system\wc04_14w.fot
c:\windows\system\wc05_14x.ttf
c:\windows\system\wc05_14x.fot
c:\windows\system\wc06_14s.ttf
c:\windows\system\wc06_14s.fot
c:\windows\system\wc06_15b.ttf
c:\windows\system\wc06_15b.fot
c:\windows\system\wcOe 14t ttf
c:\windows\system\wcOe_14t.fot
c:\windows\system\wc10_14g.ttf
c:\windows\system\wc10_14g.fot
c:\windows\system\wc20_14t.ttf
c:\windows\system\wc20_14t.fot
c:\windows\system\wc21_14t.ttf
c:\windows\system\wc21_14t.fot
c:\windows\system\wc22_14t.ttf
c:\windows\system\wc22_14t.fot
c:\windows\system\wc23_14t.ttf
c:\windows\system\wc23_14t.fot
c:\windows\system\wc25_14t.ttf
c:\windows\system\wc25_14t.fot
c:\windows\system\wc26_14t.ttf
c:\windows\system\wc26_14t.fot
c:\windows\system\wc27_14t.ttf
c:\windows\system\wc27_14t.fot
c:\windows\system\wc2al phb.fon
c:\windows\system\wc2al phr.fon
c:\windows\system\wc2cjk1.fon
c:\windows\system\wc2cjk2.fon
c:\windows\system\wc2cjk3.fon
c:\windows\system\wccl 14t ttf
c:\windows\system\wccl 14t.fot
c:\windows\system\wcfe_14sttf
c:\windows\system\wcfe 14s.fot
c:\windows\system\wcfe 15b.ttf
c:\windows\system\wcfe_15b.fot

;3-D
dialog
boxes
:UniEdit
fonts
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Installing UniEdit on a Network

Note: If you areinstalling UniEdit on a workstation which is running a network copy of Windows, you must have the
necessary network privileges to write to the network Windows system directory, even if UniEdit, is being installed on
alocal drive, since UniEdit must install its fonts and a few other system files in the common Windows directory.

UniEdit performs well in a network setting. But there are certain aspects of UniEdit performance
which you should be aware of.

UniEdit Home Directory

It isimportant to be aware of the drive letter for the “Home” and other directories specified in
WINCALIS.INI. See the various sections on changing subdirectory defaultsin The Main UniEdit
Initialization File WINCALIS.INI. It is sometimes the case with installation on a network server
that the DOS drive letter by which that server is known to aloca workstation changes. If that
happens, UniEdit will not function properly on the local workstation. Y ou will need to bring the
drive letters specified in WINCALIS.INI into line with the expectations of the local workstations.

Tips on Installing UniEdit on a Shared Network Drive from a Local Workstation

See the note at the beginning of this topic on necessary network privileges.

Install UniEdit in the desired directory on the shared network drive from one workstation. This
will create a complete installation in that workstation’s copy of Windows, including the Program
Manager group with icons and the fonts installed by UniEdit Setup.

Then in order to give UniEdit icons for the copies of Windows running on the other workstations,
you will need to copy the group file WINCALIS.GRP from that workstation’s Windows directory
to every other workstation’s Windows directory, and add the following line to each progman.ini
file:

Group8=C:=\WINDOWS\WINCALIS.GRP
(or whatever group number has been created in the original PROGMAN.INI).

You will also need to install the UniEdit fonts which were installed in the Windows System
directory (e.g., \windows\system) of the workstation used for the initial Setup (assuming that it is
running alocal copy of Windows) into the copies of Windows running on the other workstations.
Copy all the files wc2* .fon and wc* .ttf into the other windows\system directories.

Then run Control Panel in the Main group, then the Fonts applet, then Add, and change to the
\windows\system directory. After logging the fonts in that directory, holding down Citrl, click on
all fonts beginning with “WinCALIS 2.0...”. If you alternatively copy the lines from the original
machine’ s win.ini file into the other machines’ win.ini files, you will also need to copy the
respective “wc* .fot” files from the original machine.

There are two other required files to copy into the Windows System directories:
ctl3d.dll

pxengwin.dll



112

If the subdirectory and Windows desktop arrangements are the same on all the workstations, you
can make a little batch file to do these copying jobs effortlessly. Put all the above files and the
batch file, e.g., “TRANSFER.BAT,” in atemporary location somewhere on the network, say, the
Z: drive. Then run that batch file from each workstation. Y our batch file might look like this:

copy z:wincalis.grp c:\windows

copy c:\windows\progman.ini c:\windows\progmanb.ini
copy z:progman.ini c:\windows

copy z:wc2* fon c:\windows\system

copy z:wc* ttf c:\windows\system

copy z:ctl3d.dll c:\windows\system

copy z:pxengwin.dll c:\windows\system

From each workstation, you would type “ z:transfer” to perform the needed transfer of files.

How to Uninstall UniEdit

To uninstall UniEdit you will need to remove the directories and files listed below from your
machine. Y ou can use the Windows File Manager, or you can use DOS commands. UniEdit also
adds fonts to your Windows system, causing Windows to add them to the [fonts] section of your
WINL.INI file. UniEdit makes no other modifications directly to any of your Windows
initialization files, such as WIN.INI, SYSTEM.INI, etc.

Uninstalling Using the Windows File Manager:
1) Click on the File Manager icon in the Windows 3.1 Main group to start the File Manager.

2) Select the drive which contains the directory which you specified as the UniEdit program
directory during setup, e.g., the C: drive.

3) Highlight the UniEdit program directory (by default C\WINCALIS). Then press the Delete
key. When asked, press “Delete All”.

WARNING!! Thiswill delete ALL filesin ALL subdirectories under the UniEdit program
directory—over 600 filesin the case of afull installation. Be sure to exercise caution that you
have specified the correct directory, and make backup copies first of any of your own script
or document files which you wish to keep.

4) still using the File Manager, locate the main Windows directory (e.g., C\WINDOWS) and
click onit in order to display the filesin it. Delete the following file by highlighting it and
pressing the Delete key:

MLPTT.INI

5) Now locate the Windows System directory (e.g., C\WINDOWS\SY STEM) and click onitin
order to display the filesin it. Delete the following files:

WARNING!! Other applications may have also installed one or more of these files and still
need them. If you are in doubt, do NOT delete them. They will not affect the performance of
your system.

PXENGWIN.DLL  Paradox Engine library for record-keeping
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CTL3D.DLL 3-D Effectsin dialog boxes

If the following files were added through the Control Panel, Drivers, Add Driver procedure
described in a separate section below, they should also be removed through the Control
Panel.

AAPLAY.DLL Autodesk Animation Player
MCIAAP.DRV “

MCIAWI.DRV Gold Disk Animation
MCIAWI1D.DLL “

MCIAWI10.DLL “

MCIAWIL1T.TSK “

MCIMMP.DRV Microsoft Multimedia Movie Player
MCIPANASDRV  Panasonic Videodisc Player
MCIPIONR.DRV Pioneer Videodisc Player
MCIVISCA.DRV  ViSCA-compatible VCRs
MCIVSONY.DRV  Sony Videodisc Player

MMP.DLL Microsoft Multimedia Movie Player

6) Now close the Windows File Manager, and click on theicon for the Control Panel, also in the
Main group, to open the Windows Control Panel.

7) Click on the Fonts appl et.

8) Scroll through the list of “Installed Fonts” until you see the group of fonts described as
“WIinCALIS 2.0......". All such fonts were added only as part of the UniEdit Setup, and may
be safely removed as part of the Uninstall process. Highlight all these font names by either of
the following procedures:

a) While holding down the Shift key, click on the first font beginning with “WinCALIS 2.0...”,
then scroll to the last font beginning with “WinCALIS 2.0...” and click on it.

b) While holding down the Ctrl key, click on each font which begins with “WinCALIS 2.0...".

(This procedure may also be used by any UniEdit user to selectively remove unwanted fonts
from his Windows system, in order to conserve disk space, speed up Windows startup time,
etc. For example, a UniEdit who deals only with French, German, or Spanish, and is willing
to confine himself to the ANSI/Latinl character set, may choose to remove al of these extra
“WInCALIS 2.0" fonts, or at least any of the fonts for Unicode pages with exotic al phabets.)

9) Click on the Remove button. When asked for confirmation, click in the check box which says
“Delete font files from disk” and pressthe “Yesto All” button to uninstall all fonts installed
during the UniEdit Setup.

10) Close the Fonts Applet and the Windows Control Panel.

UniEdit is now completely uninstalled.






Chapter 8: UniEdit Conversions 115

Chapter 8: UniEdit Conversions

Eight-bit Code Conversions

Conversion of WinCAaLIs 1.0, WinCALis 1.1, Text CALIS *.CAL Script Files
and other 8-bit Code Text Files to and from WinCALIS 2.x

The stand-alone DOS utility WC2& 8BIT.EXE may be used to convert single or multiple text
files, including *.CAL script files, from 8-bit (single-byte) codes to WinCALIs 2.x 16-bit Unicode
(1SO 10646) code points. It can also perform the reverse function of converting WinCALIS 2.x 16-
bit Unicodes to 8-bit (single-byte) codes.

Single WinCaLis 1.1 ANSI (Latinl) text files may aso be converted upon opening them in a
UniEdit document window by selecting "ANSI/WinCaLis 1.1" in the "List Files of Type" box in
the File, Open dialog box, then saving them as UniEdit Unicode files (select the appropriate file
typein the File, Save "Save File As Type" box). Or they may be converted by copying them to
the Windows clipboard from Notepad, Microsoft Write, or other ANSI text editor, then pasting
them into UniEdit and saving them as UniEdit Unicode files.

Non-ANS| 8-bit-coded files may be converted upon opening them in UniEdit by selecting "Other
conversions' in the File, Open "List Files of Type" box. Or they may similarly be converted by
copying them to the Windows clipboard from another application, then using the Paste As...
option in the UniEdit Edit menu to convert codes "on the fly" upon pasting them into UniEdit,
and saving them as WinCALIS 2.x Unicode files or another Unicode file type.

Screens of DOS-IBM-extended ASCII coded files, such as generic Text CALIS scripts, will be
converted to ANSI in the process of copying from a DOS window to the Windows Clipboard, but
this procedure is slow for files longer than afew screens.

WC2& 8BIT.EXE can be found in the "CONVERT" subdirectory under your UniEdit program
directory if you installed the option "Code Conversion Utilities* during Setup. In order to access
this utility complete the following steps:

Go to a DOS prompt and change directories to the "CONVERT" subdirectory.
At the prompt type:

wc2& 8hit sourcefile targetfile [/n] [/r] [/t:tablefile]
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The /n switch ignores al file headers (such as the WinCALIS/Uniedit Unicode file header), in
both reading and writing files.

The direction of conversion is by default from an 8-bit-code source file to a UNICODE target file.
The /r switch reverses the direction of the conversion, that is, from a UniEdit 2 source file to an
8-bit-code target file.

The /t:tablefile switch causes the specified table file to be used for conversion. If no table nameis
specified on the command line, WC2& 8BIT.EXE will use any table it finds in the current
directory with the name WC2&8BIT.TAB. If atable nameis specified, WC2& 8BIT.EXE will
use that table instead.

Thereis limited support for DOS wild cards and paths, e.g.

WC2&8BIT *.CAL NEW

where 'new' is a subdirectory under the current directory to which converted versions of all files
with matching filename *.CAL will be written. Or:

WC2&8BIT *. TXT *.UNI

where all source fileswith file extension .TXT are converted to target files with file extension
.UNI.

Many conversion tables are supplied in the CONVERT directory. It isaso possible to compile
your own table file. The table should be a binary file with codes 1-255 (nho 0) using the following
structure:

bytes 1-2 = UNICODE 1 (Little-endian [Intel integer] order)

bytes3-4 = UNICODE 2

bytes 509-510 = UNICODE 255.
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A *.TAB table with this structure can be produced with the utilities LST2TAB3.EXE or
LST2TABS.EXE, in the CONVERT subdirectory, from a plain text file *.L ST, with one code
correspondence per line and with the codes on each line separated by tabs. Use LST2TAB3.EXE
if thefirst code is expressed in decimal and the second code (UNICODE) is expressed in
hexadecimal, e.g.,

001(tab)0001

255(tab)00AO.

Use LST2TABS.EXE if thefirst code in each lineis expressed in hexadecimal, rather than in
decimal, e.g.,

01(tab)0001

FF(tab)00AO.

If you name your *.TAB file WC2& USER.TAB, it will also be available from within WinCALIS
Author and UniEdit, via the File,Open, File,Save and Edit,Paste As... options, using the "User-
Supplied 8-bit Char. Set" item in the "Convert From" or "Convert To" dialog box.

Key to supplied conversion tables to be used with WC2& 8BIT.EXE, with filename of type
WC2& 7?72.TAB:

WC2& ANSI.TAB ASCII/ANSI(=1SO 8859/1 "Latinl", ECMA-94)
WC2&D437.TAB ASCII/DOS Code Page 437 (U.S. DOS)/IBM

"Extended ASCII" (Generic Text CALIS)

WC2& D850.TAB DOS Code Page 850 (Multilingual)
WC2& D852.TAB DOS Code Page 852 (Latin Slavic)
WC2& D855.TAB IBM Code Page 855 (Cyrillic)

WC2&D857.TAB DOS Code Page 857 (Turkish)
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WC2&D860.TAB

WC2&D861.TAB

WC2& D863.TAB

WC2& D864.TAB

WC2& D865.TAB

WC2& D866.TAB

WC2& D869.TAB

WC2& PCM4.TAB

WC2&1004.TAB

WC2&1040.TAB

WC2&1041.TAB

WC2& 1043.TAB

WC2&1250.TAB

WC2&1251.TAB

WC2&1252.TAB

WC2& 1253.TAB

WC2&1254.TAB

WC2& 1255.TAB

WC2& 1256.TAB

WC2&1257.TAB

WC2&KOI7.TAB

WC2& GO74.TAB

WC2&BRAV.TAB

WC2&BROV.TAB

WC2& RSKR.TAB

WC2& GERD.TAB

WC2&I1SCB.TAB

WC2&ISCD.TAB

WC2&ISCG.TAB

DOS Code Page 860 (Portugal)

DOS Code Page 861 (Icelandic)

DOS Code Page 863 (Canadian-French)

IBM Code Page 864 (Arabic)

DOS Code Page 865 (Nordic)

DOS Code Page 866 (Cyrillic)

IBM Code Page 869 (Greek)

PC Code Page M4

PC Code Page 1004

PC Code Page 1040 (Korean Hangul alphabet)
PC Code Page 1041 (Japanese K atakana)

PC Code Page 1043 (other East Asian SBCYS)
Microsoft Windows Code Page 1250 (E.Europe)
Microsoft Windows Code Page 1251 (Cyrillic)
Microsoft Windows Code Page 1252 (Windows ANSI)
Microsoft Windows Code Page 1253 (Greek)
Microsoft Windows Code Page 1254 (Turkish)
Microsoft Windows Code Page 1255 (Hebrew)
Microsoft Windows Code Page 1256 (Arabic)
Microsoft Windows Code Page 1257 (Baltic)
KOI-7 (Cyrillic)

GOST 19768-74 (Old KOI-8 Cyrillic)
Brjabrin's Alternativnyj Variant (Cyrillic)
Brjabrin's Osnovnoj Variant (Cyrillic)
AATSEEL "REX" (Cyrillic)

"Gerdsooz" encoding for Persian Farsi

ISCII 1988 Indian Standard (Bengali)

ISCII 1988 Indian Standard (Devanagari)

ISCII 1988 Indian Standard (Gurmukhi)
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WC2&ISCJ.TABISCII 1988 Indian Standard (Gujarati)

WC2&ISCK.TAB

WC2&ISCM.TAB

WC2&ISCO.TAB

WC2&ISCT.TAB

WC2&ISCU.TAB

WC2&1SO1.TAB

WC2&1S0O2.TAB

WC2&1SO3.TAB

WC2&1S04.TAB

WC2&1S0O5.TAB

ISCII 1988 Indian Standard (Kannada)

ISCII 1988 Indian Standard (Malayalam)

ISCII 1988 Indian Standard (Oriya)

ISCII 1988 Indian Standard (Tamil)

ISCII 1988 Indian Standard (Telugu)

1SO 8859/1 ("Latinl") (same as WC2& ANSI.TAB)
SO 8859/2 ("L atin2"-Eastern Europe, etc.)

SO 8859/3 ("L atin3"-Eastern Europe, etc.)

SO 8859/4 ("L atind"-Eastern Europe, etc.)

SO 8859/5 (=ECMA-113,GOST 19768-87,

New KOI-8 Cyrillic)

WC2&1S06.TAB

SO 8859/6 (=ECMA-114,ASMO 449)

(Arabic, Farsi, etc.)

WC2&1S07.TAB

WC2&1SO8.TAB

WC2&1S09.TAB

WC2&ISOA.TAB

WC2&1SOG.TAB

WC2& MACA.TAB

WC2& MACC.TAB

WC2& MACE.TAB

WC2& MACG.TAB

WC2&MACI.TAB

WC2& MACL.TAB

WC2& MACN.TAB

WC2& MACR.TAB

WC2& MACS.TAB

WC2& MACT.TAB

ISO 8859/7 (=ECMA-118,ELOT 928) (Greek)
|SO 8859/8 (Hebrew)

SO 8859/9

1SO 6438 (=DIN 31625) (African Extended Latin)
I SO 5428-1980 (Bibliographic Greek)
Macintosh Arabic Character Set

Macintosh Cyrillic Character Set

Macintosh Central Europe Character Set
Macintosh Greek Character Set

Macintosh Icelandic Character Set

Macintosh Latin (Roman) Character Set
Macintosh Croatian Character Set

Macintosh Romanian Character Set
Macintosh (Adobe) Symbol Character Set

Macintosh Turkish Character Set
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WC2&MACU.TAB Macintosh Ukrainian Character Set

WC2&TIS6.TABThai Industrial Standard 620-2529

WC2& USER.TAB User-supplied 8-bit Character Set
WC2&VSCI.TAB VISCII Vietnamese Standard
WC2& WC1B.TAB WINCALIS 1.0 BASE.FON (English,French,

German,ltalian,Portuguese, Spanish)
WC2&WC1C.TAB WINCALIS 1.0 CYRILLIC.FON (Russian)
WC2&WC1E.TAB WINCALIS 1.0 EEUR.FON

(Polish, Hungarian, generic East Europe, etc.)

WC2&WC1G.TAB WINCALIS 1.0 PGREEK.FON (Greek)

WC2&WC1J.TAB WINCALIS 1.0 HIRAGANA.FON (Japanese hiragana)
WC2&WCI1K.TAB WINCALIS 1.0 KATAKANA.FON (Japanese katakana)
WC2&WC1V.TAB WINCALIS 1.0 VIETNAME.FON (Vietnamese)

WC2& CALA.TAB Amharic Text CALIS

WC2& CALE.TAB East European Text CALIS

WC2& CALG.TAB Greek Text CALIS

WC2& CALH.TAB Hebrew Text CALIS

WC2& CALP.TAB Portuguese Text CALIS

WC2& CALR.TAB Russian Text CALIS

The files WC2& D437.L ST (and LST2TAB3.EXE) and WC2&1SO1.L ST (and LST2TABS5.EXE)
can serve as templates from which to create more conversion tables for use with
WC2& 8BIT.EXE.

For conversion between various 2-byte coding standards (e.g., for Chinese, Japanese, Korean,
Unicode 1.0 or 1.1) and UniEdit Unicode 2.0, use the following separate utilities (requires
UniEdit Workstation Setup CIK Conversions Disk):

WC2&16BT.EXE for 16-bit fixed-width coded files
DCT2UNI.EXE for Duke Chinese Typist 2.0 coded files

WC2& EAST.EXE for JIS, Shift-J'S, EUC, Big5, GB, KS, and other 7-bit modal or mixed
16-bit and 8-hit coded files.
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WC2&24BT.EXE for 24-bit fixed-width coded files such as CCCll or EACC/ANSI Z39.64

UCS2& UTF.EXE for UTF-7 and UTF-8 coded Unicode files.

Sixteen-bit Code Conversions

Conversion of East Asian double-byte files consisting of modal 7-bit or
mixed 16-bit and 8-bit codes to and from UniEdit

The stand-alone DOS utility WC2& EAST.EXE may be used to convert single or multiple text
files from modal 7-bit or mixed 16-bit/8-bit coding standards such as JIS, SHIFT-JIS, KS, Big5,
or GB code to UniEdit 16-bit Unicode (1SO 10646) files. It can aso perform the reverse function
of converting UniEdit 16-bit Unicodes to modal 7-bit or mixed 16-bit and 8-hit coding standards.
For modal 7-bit coded files, use the "EUC" coding table (e.g.,for Japanese, use the table

EUCJ& UNI.TAB).

Single files can be converted by opening or saving them in UniEdit and selecting " Other
conversions' inthe "List files of type" or "Save file as type" box. Or they may be converted by
copying them to the Windows clipboard from the source application, then pasting them into
UniEdit using the Paste As... option in the Edit menu to convert codes "on the fly" during
pasting, and saving them as UniEdit Unicode files.

WC2& EAST.EXE can be found in the CONVERT subdirectory under your UniEdit program
directory. In order to access this utility, do the following:

Go to a DOS prompt and change to "CONVERT" subdirectory
At a DOS prompt type the command line:

wc2&east sourcefile targetfile [/n] [/r] [/m] [/t:tablefile]

The /n switch ignores al file headers (such as the WinCALIS/Uniedit Unicode file header), in
both reading and writing files.

The direction of conversion is from amodal 7-bit or mixed 16-bit/8-bit source file to a UniEdit
Unicode target file by default. The /r switch reverses the direction of the conversion, that is, from
a UniEdit source file to amodal 7-bit or mixed 16-bit/8-bit-code target file.
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The /m switch, when used in conjunction with the /r switch, specifies conversion from UniEdit
Unicode source file to amodal 7-bit target file (i.e., afilein which al codes are 7-bit codes, with
language shifts marked by Escape codes).

The /t:tablefile switch causes the specified table file to be used for conversion. If no table nameis
specified on the command line, WC2& EAST.EXE will use any table it finds in the current
directory with the name WC2& EAST.TAB. If atable name is specified, WC2& EAST.EXE will
use that table instead.

Thereis limited support for DOS wild cards and paths ,e.g.,

WC2&EAST *.GB NEW

where 'new' is a subdirectory under the current directory to which converted versions of all files
with matching filename *.GB will be written. Or:

WC2&EAST *.GB *.UNI

where all source files with file extension .GB are converted to target files with file extension
.UNI.

Several conversion tables are supplied in the CONVERT subdirectory. It isaso possible to
compile your own table file. The table should be a binary file with the following structure:

bytes1-2 = Source (GB, Big5, etc.) code 1 (Little-endian byte-reversed)
bytes3-4 = Unicode 1 (Big-endian)
bytes5-6 = Source (GB, Big5,etc.) code 2

bytes7-8 = Unicode 2

A *.TAB table with this structure can be produced with the utility SJIS2WC2.EXE, in the
CONVERT subdirectory, from a plain text file *.L ST, with one code correspondence per line and
with the codes on each line separated by tabs, e.g.,
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8140(tab)3000

EAA4(tab)7199.

Usage: SIS2WC2 LISTFILE.LST

Key to supplied conversion tables to be used with WC2& EAST.EXE, (rename as
WC2& EAST.TAB or type filename after /t:tablefile switch):

B5& WCUNI.TAB Big-5 codes (Taiwan Chinese)
EUCJX.UNI.TAB Extended Unix Codes (Japanese)

(use thistable for JS modal 7-bit conversion)

GB&WCUNI.TAB GB-2312-80 codes (simple-style Chinese)
KSIH&UNLTAB Korean Johab codes --> Unicode 1.1
KSIH&UN2.TAB Korean Johab codes --> Unicode 2.0
KSWS&UNLTAB KS-C5601 Korean Standard Wansung --> Unicode 1.1
KSWS&UN2.TAB KS-C5601 Korean Standard Wansung --> Unicode 2.0
KSUH&UN1.TAB Korean "Unified Hangul" codes --> Unicode 1.1
KSUH&UN2.TAB Korean "Unified Hangul" codes --> Unicode 2.0
SIS&UNI.TAB Shift-JIS codes (Japanese)

The corresponding files B5& WCUNI.LST, EUCJ& UNI.LST, GB& WCUNI.LST,
KSJH&UN1.LST, etc. can serve as templates from which to create more conversion tables for use
with WC2& EAST.EXE.

For conversion between various single-byte (8-bit) coding standards, use the parallel utility
WC2&8BIT.EXE in the CONVERT subdirectory.

Other DBCS (double-byte character set) utilities are explained below.
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Conversion of fixed-width double-byte (16-bit) files to and from
UniEdit

Conversion of Duke Chinese Typist files

Use DCT2UNI.EXE with the table DCT2UNI.TAB to convert Duke Chinese Typist 2.0 coded
filesto Unicode.

In order to access this utility, do the following:

Go to a DOS prompt and change to "CONVERT" subdirectory
At a DOS prompt type the command line:

dct2uni sourcefile targetfile [/n] [/r] [/t:tablefile]

The /n switch ignores al file headers (such as the WinCaLis/Uniedit Unicode file header), in
both reading and writing files.

The direction of conversion isfrom a DCT source file to a UniEdit Unicode target file by default.
The /r switch reverses the direction of the conversion, that is, from a UniEdit sourcefileto a
DCT target file.

The /t:tablefile switch causes the specified table file to be used for conversion. If no table nameis
specified on the command line, DCT2UNI.EXE will use any tableit findsin the current directory
with the name DCT2UNI.TAB. If atable nameis specified, DCT2UNI.EXE will use that table
instead.

Thereis limited support for DOS wild cards and paths, e.g.,

DCT2UNI *.DC2 NEW
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where 'new' is a subdirectory under the current directory to which converted versions of all files
with matching filename *.DC2 will be written. Or:

DCT2UNI *.DC2 *.UNI

where all source files with file extension .DC2 are converted to target files with file extension
.UNI.

Conversion of Miscellaneous Fixed-width 16-bit files

Types of fixed-width 16-bit codes you may wish to convert include the following:

conversion of text files from various other East Asian word-processing programs

conversion of older or non-standard Unicode-format files, e.g., of Unicode 1.0 or 1.1-
coded files to Unicode 2.0

Use the table U10&U11.TAB and/or the table U11&U20.TAB, or modified versions of
them (see below).

conversion between simple-style Chinese and complex-style Chinese.

Use the tables SMP2CMP.TAB or CMP2SMP.TAB.

Note: Since a simple-style-->complex-style Chinese conversion is one-->many and no intelligence is employed, it will
require post-editing by someone familiar with proper traditional usage.

conversion of files with Korean KS Hanja Compatibility Codes to "pure Unicode"
Use the table KORCOMP.TAB.

conversion of filesin the WinCaLis/UniEdit full code set (including private codes,
"compatibility" character codes, and Arabic-script Presentation Characters) to "pure
Unicode"

Use the table WC& PURUN.TAB.

Note: UniEdit maintains some distinctions among Han characters which are not maintained in the Unicode Han
character set, by mapping one of the glyphic forms to a code in part of the private-use code space, in the range FOO0-
F1FF. It is our desire to maintain distinctions of significance to language teachers and students within Unicode plain
text (without formatting information) and without "escape codes' in the character stream, indicating that the
following character is to be understood as " Japanese," or "Korean," etc. This affects approximately 400 Han
characters, usually glyphic variations between the Chinese and Japanese character sets or the "standard" P.R.C. and
Taiwan character sets, such as the distinct simple-style Chinese and Japanese joydkanji glyphs for U+4EQE, virtually
all characters with the "silk radical" (Kangxi radical 120), and most characters with the "bone" radical (Kangxi
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radical 188). Here is a sample of the code equivalences (see the file "wc& purun.lst” in the ..\convert subdirectory for
the complete list):

UniEdit "Pure"
Unicode Unicode
FOO1 4EQOE
F002 50B2
FO03 533E
FO04 5448
FO05 548E
FO06 55F7

When you convert files to "pure” Unicode, these distinctions are lost and cannot be recovered.

In addition, certain other composite characters are also mapped to private-use codes, such as Cyrillic vowels with
acute accents (F700-F715), Roman letters with exotic diacritic combinations (F600-F6FF), etc. These characters
cannot yet be decomposed automatically during conversion into their component parts.

Single files can be converted by opening or saving them in UniEdit and selecting " Other
conversions' inthe "List files of type" or "Save file as type" box. Or they may be converted by
copying them to the Windows clipboard from the source application, then pasting them into
UniEdit using the Paste As... option in the Edit menu to convert codes "on the fly" during
pasting, and saving them as UniEdit Unicode files.

To convert many files at once, you may use the DOS utility WC2& 16BT.EXE at the DOS
prompt.

WC2& 16BT.EXE can be found in the CONVERT subdirectory under your UniEdit program
directory. In order to access this utility, do the following:

Go to a DOS prompt and change to "CONVERT" subdirectory
At a DOS prompt type the command line:

wc2&16bt sourcefile targetfile [/n] [/r] [/t:tablefile]

The /n switch ignores al file headers (such as the WinCaLis/UniEdit Unicode file header), in
both reading and writing files.

The direction of conversion is from a non-Unicode 2.0 16-bit source file to a UniEdit Unicode
target file by default. The /r switch reverses the direction of the conversion, that is, from a
UniEdit source file to a non-Unicode 2.0 16-bit target file.
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The /t:tablefile switch causes the specified table file to be used for conversion. If no table nameis
specified on the command line, WC2& 16BT.EXE will use any table it finds in the current
directory with the name WC2& 16BT.TAB. If atable nameis specified, WC2& 16BT.EXE will
use that table instead.

Thereis limited support for DOS wild cards and paths ,e.g.,

WC2&16BT *.U10 NEW

where 'new' is a subdirectory under the current directory to which converted versions of all files
with matching filename *.GB will be written. Or:

WC2&16BT *.U11 *.U20

where all source files with file extension .U11 are converted to target files with file extension
.U20.

Y ou can modify any of the binary *.TAB tables above or construct a new one with the included
utility LST2TABH.EXE by modifying or imitating the *.L ST text source files of the above

* TAB files. Each *.L ST file has one code correspondence per line, with the codes on each line
separated by tabs, e.g.,

AE26(tab)5E76

EAA4(tab)7199.

Usage: LST2TABH LISTFILE.LST

Twenty-four-bit Code Conversions

Twenty-four-bit (triple-byte) fixed-width coding standards include CCCIll and EACC/ANSI
Z739.64. Y ou may convert files using these codes to UniEdit files with 16-bit Unicode UCS-2
character codes in one of the following ways.
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Single files can be converted by opening or saving them in UniEdit and selecting " Other
conversions' in the "List files of type" or "Save file as type" box. Or they may be converted by
copying them to the Windows clipboard from the source application, then pasting them into
UniEdit using the Paste As... option in the Edit menu to convert codes "on the fly" during
pasting, and saving them as UniEdit Unicode files.

To convert many filesin "batch mode" rapidly at once, you may use the DOS utility
WC2& 24BT.EXE at the DOS prompt.

WC2& 24BT.EXE can be found in the CONVERT subdirectory under your UniEdit program
directory. In order to access this utility, do the following:

Go to a DOS prompt and change to "CONVERT" subdirectory
At a DOS prompt type the command line:

wc2&24bt sourcefile targetfile [/n] [/r] [/t:tablefile]

The /n switch ignores al file headers (such as the WinCALIS/Uniedit Unicode file header), in
both reading and writing files.

The direction of conversion is from a 24-hit (3-byte) coded source file to a UniEdit Unicode
target file by default. The /r switch reverses the direction of the conversion, that is, from a
UniEdit source file to a 24-bit target file.

The /t:tablefile switch causes the specified table file to be used for conversion. If no table nameis
specified on the command line, WC2& 24BT.EXE will use any table it finds in the current
directory with the name WC2&24BT.TAB. If atable nameis specified, WC2& 24BT.EXE will
use that table instead.

Thereis limited support for DOS wild cards and paths ,e.g.,

WC2&24BT * . EAC NEW

where 'new' is a subdirectory under the current directory to which converted versions of all files
with matching filename * .EAC will be written. Or:
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WC2&24BT *.EAC *.UNI

where all source files with file extension .EAC are converted to target files with file extension
.UNI.

Key to supplied conversion tables to be used with WC2& 24BT.EXE, (rename as
WC2& 24BT.TAB or type filename after /t:tablefile switch):

CCCI&UNI.TAB CCCII codes (Taiwan Chinesg)

EACC&UNI.TAB EACC/ANSI 739.64 (REACC) codes (library MARC records, such as Research
Libraries Network, Library of Congress etc.)

Y ou can modify any of the binary *.TAB tables above or construct a new one with the included
utility LST2TABG6.EXE by modifying or imitating the *.L ST text source files of the above *. TAB
files. Each *.L ST file has one code correspondence per line, with the codes on each line
separated by tabs, e.g.,

213021 (tab)4E00

70775D(tab)9BOF.

Usage: LST2TABG LISTFILE.LST

UTF-7 and UTF-8 Conversions

Y ou may convert Unicode files with codes in the "Universal Coded Character Set Transformation
Format" UTF-7 (7-bit codes) or UTF-8 (8-bit codes) to UniEdit files with 16-bit UCS-2 character
codes in one of the following ways.

Single files can be converted by opening or saving them in UniEdit and selecting "UTF-7/UTF-8"
inthe"List Files of Type" or "Save File as Type" box.
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To convert many filesin "batch mode" rapidly at once, you may use the DOS utility
UCS2& UTF.EXE at the DOS prompt.

UCS2& UTF.EXE can be found in the CONVERT subdirectory under your UniEdit program
directory. In order to access this utility, do the following:

Go to a DOS prompt and change to "CONVERT" subdirectory
At a DOS prompt type the command line:

ucs2&utf sourcefile targetfile [/n] [/r] [/7]

The /n switch ignores al file headers (such as the WinCALIS/Uniedit Unicode file header), in
both reading and writing files.

The direction of conversion isfrom a Unicode UTF-7 or UTF-8 coded source file to a UniEdit
Unicode UCS-2 coded target file by default. The /r switch reverses the direction of the
conversion, that is, from a UniEdit source fileto aUTF-7 or UTF-8 target file.

The /7 switch, used in conjunction with the /r switch, converts from UCS-2 to UTF-7. By default
conversion will beto UTF-8.

Thereis limited support for DOS wild cards and paths ,e.g.,

UCS2&UTF *.UTF NEW

where 'new' is a subdirectory under the current directory to which converted versions of all files
with matching filename * .UTF will be written. Or:

UCS2&UTF *.UTF *.UCS

where all source files with file extension .UTF are converted to target files with file extension
.UCs.
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